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Preface

Welcome to the Oracle Contracts Core User Guide, Release 11i. This guide 
provides information and instructions to help you work effectively with Oracle 
Contracts Core.

This preface explains how this user guide is organized and introduces other sources 
of information that can help you.

Intended Audience
This guide is aimed at the following users:

� Contract Administrators

� Contract Managers

� Technical Service Representatives (TSR)

� Customer Service Representatives (CSR)

� System Administrators (SA), Database Administrators (DBA), and others with 
similar responsibility.

This guide assumes you have the following pre-requisites:

1. Understanding of the company business processes.

2. Knowledge of products and services as defined by your marketing policies.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
xi



documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/.

Structure
This manual contains the following chapters:

Chapter 1 Introduction to Contracts Core 
This chapter provides an overview of the application and its key features, as well as 
the application’s relationships to other Oracle applications.

Chapter 2 Overview of Using Contracts Core 
This chapter provides procedures for accessing the application along with an 
overview of the top-level main components of the UI.

Chapter 3 Contract Authoring 
This chapter provides the procedures for creating a contract, defining the contract, 
and contract approval.

Chapter 4 Contract Execution
This chapter provides the insight into monitoring contractual items which affect 
execution. 

Chapter 5 Contract Administration
This chapter provides procedures for contract change requests, subcontracts, 
renew/extend/terminate contracts, and so on. Running contracts reports are also 
covered in this chapter.

Chapter 6 Using Contracts Online
This chapter explains the concepts and procedures for using this web based feature 
of Contracts Core.
xii



Chapter 7 Using Opportunity Integration
This chapter explains how an Opportunity can be created in contracts.

Other Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Contracts Core.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). Online 
help patches are available on OracleMetalink.

Related Documentation
Oracle Contracts Core shares business and setup information with other Oracle 
Applications products. Therefore, you may want to refer to other product 
documentation when you set up and use Oracle Contracts Core.

You can read the documents online by choosing Library from the expandable menu 
on your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle Contracts Core 
(and any other Oracle Applications products). This guide also includes information 
on setting user profiles, as well as running and reviewing reports and concurrent 
processes.

You can access this user’s guide online by choosing ”Getting Started with Oracle 
Applications” from any Oracle Applications help file.
xiii



Documents Related to This Product

Oracle Contracts Core Implementation Guide
This implementation guide explains the tasks and considerations required to set up 
Oracle Contracts Core.

Oracle Sales Contracts Concepts and Procedures 
Use this manual to learn more about using the Sales Contracts functionality in 
Oracle Contracts Core.

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product 
user’s guides and implementation guides.

Oracle Applications Supplemental CRM Installation Steps
This guide contains specific steps needed to complete installation of a few of the 
CRM products. The steps should be done immediately following the tasks given in 
the Installing Oracle Applications guide.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
xiv



(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screen shots, and other information that you need 
to run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Oracle Workflow Guide
This guide explains how to define new workflow business processes as well as 
customize existing Oracle Applications-embedded workflow processes.You also use 
xv



this guide to complete the setup steps necessary for any Oracle Applications 
product that includes workflow-enabled processes.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Contracts Core implementation team, as well as for users responsible for the 
ongoing maintenance of Oracle Applications product data. This manual also 
provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on OracleMetalink

Oracle Manufacturing APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual
This manual describes Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.

Oracle CRM Application Foundation Implementation Guide
Many CRM products use components from CRM Application Foundation. Use this 
guide to correctly implement CRM Application Foundation.
xvi



Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle Contracts 
Core and reach full productivity quickly. You have a choice of educational 
environments. You can attend courses offered by Oracle University at any one of 
our many Education Centers, you can arrange for our trainers to teach at your 
facility, or you can use Oracle Learning Network (OLN), Oracle University’s online 
education utility. In addition, Oracle training professionals can tailor standard 
courses or develop custom courses to meet your needs. For example, you may want 
to use your organization’s structure, terminology, and data as examples in a 
customized training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Contracts Core working 
for you. This team includes your Technical Representative, Account Manager, and 
Oracle’s large staff of consultants and support specialists with expertise in your 
business area, managing an Oracle8i server, and your hardware and software 
environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use OracleMetalink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.
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Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
software modules for financial management, supply chain management, 
manufacturing, project systems, human resources and customer relationship 
management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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Introduction to Oracle Contracts
1

Introduction to Oracle Contracts Core

This chapter provides overview of the application, key features, as well as the 
application’s relationships to other Oracle applications. This chapter includes:

� Contracts Core Overview

� Contracts Core Features

� Relationship to Other Oracle Applications

1.1 Contracts Core Overview
Oracle Contracts Core is designed for any company in any business that requires 
contracts independent of or in support of buying and selling activities.Whether the 
organization is the buyer or the seller, whether it issues contracts or receives them, 
Oracle Contracts Core automates the full life cycle of a contract. 

You can author, execute and control non-industry specific contracts with Contracts 
Core, for both buy and sell contracts. It helps companies manage internal and 
external obligations, control daily deliverables, and be focussed on contractual 
goals. To ensure that you receive everything you negotiated for and provide 
everything you committed to delivering, Oracle Contracts Core helps track 
"hidden" deliverables enforceable requirements that may not be listed as a line item 
in a contract, but are described in terms and conditions. 

The Contracts Core module acts as a central repository for the collection and 
dissemination of contract information. It contains all data on terms and conditions, 
deliverables, and parties to the contracts. This repository is the key to provide a 
single source for all the information in any contract in your enterprise.

Contracts Core is the foundation for other contract modules in the Oracle Contracts 
Suite. This foundation includes the contract repository, contract events, changes to 
contracts, renew/ extend/terminate contracts, and so on. Contracts Core leverages 
 Core 1-1



Contracts Core Features
Oracle Workflow for alerting parties to upcoming and missed deliverables. 
Contracts Core functionality is extended through integration to other Oracle 
E-Business modules. 

1.2 Contracts Core Features
Contracts Core offers the following features for automated contract management:

Launch Screens: The main entry points to Contracts Core are two launch screens. 
the Launchpad and the Contract Navigator, from which contract administrators can 
access notifications, alerts of upcoming deliverables, and the contracts repository. 

Authoring: You can create a variety of contracts from templates, copy existing 
contracts or parts of them, or simply create new contracts. The authoring form 
allows for multi-party, multi-contracts by party, and multi-line contracts, and the 
lines can expand for the addition of unlimited levels of detail. Pricing can be set at 
either the main line or the sub-line levels. The query function enables you to search 
for contracts based on attributes such as contract number, category, start and end 
dates, status, parties, or contacts. 

Attachments: This feature allows for attachment of required external documents, 
such as word processor documents, spreadsheets, and other documents required for 
reference purposes, that are not designed to be entered into the Contracts Core 
module. A feature of the attachments is the ability to link images, to support those 
contracts which have been optically scanned and stored. This will be of value to a 
company (even if the contracts are closed or terminated) as it will provide valuable 
reference information.

Library of Terms and Conditions: Contracts Core offers a library where you can 
define and maintain standard articles, the textual terms and conditions of any 
contract. Defined articles can be industry-standard regulations or terms that an 
internal legal staff has created and approved, for use in contracts. You can copy a 
standard article from the library and modify it for a specific contract, without 
affecting other contracts that use that standard article. 

Contract Rules: Contracts Core has the ability to enforce terms and conditions 
(articles) via contract rules. These rules are real-life enterprise business-process rules 
(such as invoice terms, payment terms, and price lists) that automate the processes 
that refer to a contract. Contract rules offer a structured way of representing the 
contractual terms and conditions that drive the activities performed under a 
contract. Rules can be organized into rule groups that meet company-specific needs. 

Quality Assurance: To ensure that published contracts meet quality guidelines, 
Contracts Core provides a quality-assurance (QA) checking capability. This check 
1-2 Oracle Contracts Core User Guide



Contracts Core Features
can include a list of items that need to be verified as complete or validated against 
other information before a contract is submitted for approval. 

Subcontracting: Contracts Core offers subcontracting capability for those who need 
to establish contracts with third parties in order to provide some or all of the items 
(or materials, deliverables, and so on) required for fulfilling the obligations of an 
existing contract. 

Contract Preview and Report: Contracts Core supports contract printing from the 
Authoring form. This functionality allows companies to tailor the look and feel of 
the contract, allowing for the formatting and previewing of a contract’s details, 
including the contract header information, parties, lines, and articles. The contract 
previewing solution uses XML to output the data as an HTML file which can then 
be printed. 

Discoverer Reports: There are two Discoverer reports available with Contracts 
Core: 

� Contracts Expired but not Renewed: This report searches for missed 
opportunities (contracts that have expired but were not renewed). 

� Contract Listing: This report allows the user to use the same search criteria as 
the Search Templates and Contracts Query window to identify contracts and 
view the list in Discoverer.

Tasks and Events: Used for managing and enforcing deliverables. Examples of 
contract deliverables include a status report due weekly, on Wednesday; or a report 
due 10 days after an injury accident occurs; or drug-free certification due within 30 
days of signing the contract; or a sales representative must be notified 30 days 
before a contract expires. The system automatically alerts anyone involved in the 
contract process of upcoming events and pending deliverables and also provides 
multiple levels of escalation when there are no responses to an alert within some 
predetermined time.

Contract Management: Provides the complete functionality for managing and 
executing contracts, including such actions as approvals, extensions, renewals, and 
terminations. Furthermore, you can define your own contract statuses and indicate 
whether or not certain operations (for example, delete allowed, update online, 
update via change request) can be performed on a contract that has a given status. 

Contract Execution: Contracts Core enables an integrated data view approach 
whereby you can gain an overview of the contract’s execution. These features 
include summaries of the contract’s scheduled deliverables, the contract’s history 
with drill down capability, interactions related to the contract, and documents 
related to the contract.
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1.3 Relationship to Other Oracle Applications
Contracts Core functionality is extended through integration with the following 
Oracle applications:

General Ledger: Integration points include currency definitions, daily rates, and 
conversions. This information is found in the contract header.

Human Resources: Integration points include employee definitions, locations, and 
organizations. This is used to access contracts and when entering party information 
for a contract.

Purchasing: Integration points include buyer definition and supplier information. 
This information is used when entering the party for a “Buy” contract. 

Payables: Integration points include payment, tax, invoice, withholding, receiving 
rules, and so on. This information is used for entering rules of a buy contract in the 
contract summary.

Pricing: Integration points include pricelists, adjustments, discounts, promotions, 
and surcharges. This information is used for retrieving pricing information when 
authoring a “Sell” contract.

Configurator: Integration points include pricing, configured item numbers, parent 
item numbers, inventory item numbers, component BOM codes, item quantity, and 
UOM. 

Inventory: Integration points include items, units of measure, units of measure 
conversions and classes. This integration enables the use of an inventory item as a 
contract line item.

Receivables: Integration points include parties, customers, sales representatives, tax 
exemptions, and terms. This is used when defining the Contract Party information.

Foundation Applications:

� Interaction History: Integration points include resources, actions, and 
outcomes. This integration enables the recording of customer interactions on 
the contract.

� Task Manager: Integration points include resources, roles, and task status. This 
integration enables you to assign tasks for specific contract deliverables. 

� Resource Manager: Integration points include resources, roles, and categories. 
This integration enables the assignment of a task to a resource.
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Overview of Using Contracts Core

This chapter provides procedures for accessing the application along with an 
overview of the top-level main components of the User Interface (UI).

The following topics are covered:

� Accessing Contracts 

� Using the Launchpad and Navigator

� Opening a Contract

� Finding a Contract

� Contract Index

� Contract Attachments

� Contracts Core Functional Components

2.1 Accessing Contracts
This procedure is used for log on to a Contracts module.

Prerequisites
Before accessing Oracle Applications, you must have a User Name and Password. A 
contracts responsibility must be assigned to your User Name such as Contracts 
Manager, Service Contracts Manager, etc. 

Steps
1. Navigate to the Oracle Applications window for log on. 

2. Enter User Name.
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3. Enter Password.

4. Click Connect. After successful log on the Responsibilities window appears.

5. Select a responsibility (for example Contracts Manager for access to Core 
Contracts).

6. Click OK. The Navigator - Contracts Manager window appears.

7. Select a component and click Open.

Guidelines
To change responsibilities, navigate to File > Switch Responsibility. The 
Responsibilities window appears. If you do not find a specific responsibility, contact 
your system administrator.

Contracts are launched from the Navigator window. This is the first window that 
appears after you have accessed the application. This window has a Functions tab 
and Documents tab. The Functions tab displays the major application functions 
such as Launch Contracts, Contract Groups, Setup, and so on. The Documents tab 
enables you to create and display a list of documents that are easily accessible.

The function “Launch Contracts” is selected as a default. When you click Open the 
Oracle Contracts window appears having the Launchpad and Contract Navigator 
tabs.

2.2 Using the Launchpad and Navigator 
The main entry points to Contracts are the Launchpad and the Contract Navigator 
tabs. Contract administrators can access notifications, alerts of upcoming 
deliverables, and the contracts repository. This topic covers the following features:

Using the Contract Launchpad Tab

Using the Contract Navigator Tab

2.2.1 Using the Contract Launchpad Tab 
The Launchpad tab is divided into three regions: Inbox, Recent Documents, and 
Bookmarked Documents.

The Inbox displays notifications for contracts that require action.

� Find searches for a contract by status or notification type.

� Open opens a contract selected in the Inbox.
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� Respond invokes workflow functions such as approving, signing, or rejecting a 
contract.

The Recent Documents region displays and gives you access to the most recently 
modified documents. 

Use the Bookmarked Documents region to maintain your own personal list of 
contracts.

2.2.1.1 Using the Inbox
When you press the right mouse button (within the Inbox) the following list of 
functions are displayed in a pop-up menu:

� Copy Cell

� Copy Selected Rows

� Copy All Rows

� Find in Table (Find Launch Inbox window)

� Refresh

� Sort

The copy functions enable you to paste the cells to an Excel spreadsheet or a Word 
document. It keeps the table format which means that you can copy the entire 
navigator to an Excel spreadsheet. Using the Sort window, you can sort contracts in 
any order you like such as Date, Priority, Status, and so on.

To find a contract in the Inbox, you can either scroll the list of contracts and select a 
contract or search contracts by status or notification type then execute a search 
using the Inbox Find window. 

Steps

Finding a Contract with the Inbox Find Window
1. From the Navigator, choose Launch Contracts and click Open.

2. Click Find. The Inbox Find window appears.

3. Select Contract Status from the LOV.

4. Select Notification Type from the LOV.

5. Click Find. Contracts matching your search criteria appears in the Inbox.
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Responding to a Contract
6. Select a contract in the Inbox.

7. Click Respond. This launches a Workflow window.

8. Perform the necessary Workflow functions. After updating in workflow the 
new contract status is shown in the Subject column.

Opening a Contract
9. If necessary, select Refresh by pressing the right mouse button from within the 

Inbox.

10. Select the contract in the Inbox.

11. Click Open. The Contracts Authoring window appears allowing you to browse 
or update the contract.

2.2.1.2 Opening a Contract in Recent Documents
When you do a mouse right-click (within Recent Documents) a list of functions 
appear in a pop-up menu. These are the same functions (See, Using the Inbox) as in 
the pop-up menu for the Inbox. 

Steps
1. From the Navigator, choose Launch Contracts and click Open.

2. If necessary, select Refresh (within Recent Documents).

3. Select a contract or when there are many contracts, use “Find in Table”.

4. Click Open. The Contracts Authoring window appears allowing you to browse 
and update the contract.

2.2.1.3 Bookmarking a Contract

Steps
1. From the Contracts Authoring window, select Actions > Bookmark. A Note 

window appears with a message confirming the Bookmark.

2. Click OK.

3. Navigate to Oracle Contracts (T) Launchpad.

4. If necessary, select Refresh (within Bookmarked Documents).

5. Select (or use Find in Table) your contract in Bookmarked Documents.
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6. Click Open.The Contracts Authoring window appears allowing you to browse 
and update the contract.

7. If you want to remove a contract from the list, select the contract and click 
Remove.

2.2.2 Using the Contract Navigator Tab
Use the Contract Navigator tab to view contracts by contract groups. This tab is 
divided into two sides. The left side displays the contract groups and the right side 
displays the contracts in a grid that belong to the group you select from the left.

From the grid you can right-click to invoke several contract administration 
functions, or you can double-click the contract to get a quick overview of the 
contract. In addition to the overview, double-clicking gives you access to the 
contract history, schedule, and communications.

Contract Groups
Contract groups provide a convenient way to organize contracts using any criteria 
you like. They are similar to folders.

Create as many contract groups as needed to help you and other users find related 
information about contracts and contract parties. You can use any number of groups 
to classify a single contract and you can nest groups within other groups. 

The groups you create can be public or private. Use public groups to group your 
contracts in a structured way that follows your company or department 
organization structure or business procedures. Use private groups to allow users to 
group contracts by their personal preferences.

If the system administrator gives you the privilege, then you can also create public 
groups that are accessible to all users. Public groups can contain individual 
contracts as well as other public or private groups.

Groups do not permit or restrict access to contracts. 

Note: A very large number of contracts in a contract group will 
adversely impact performance. You can increase performance by 
adding subfolders and distributing the contract into more 
subcontracts.
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2.2.2.1 Accessing Pop-up Menu Functions
Within the Oracle Contracts window, you can use the Contract Navigator tab to 
access a variety of functions related to finding, creating, viewing, and managing 
contracts. From the Navigator tab (in the right pane) you can press the right mouse 
button and a pop-up menu appears showing these functions (you can also access 
these from Tools on the menu bar):

2.3 Opening a Contract
Use this procedure to open an existing contract. 

Function Description

New Before authoring a contract, you must create it first using the 
Create a New Contract window.

Open Right-click a contract from the Contract Navigator to open the 
Contracts Authoring window.

Create New Version You can create a new contract version by selecting a contract 
and pressing the right mouse button.

Create Change Request Change Requests enable you to document changes to a contract 
and submit for approval.

Copy You can copy a contract or parts of a contract using the Copy 
window.

Subcontract You can copy a contract or parts of a contract to create a 
subcontract using the Subcontract window.

Renew Using the Renew Contracts window, you can renew an existing 
contract.

Change Status Using the Contract Status window, you can change the status of 
a contract.

Extend Using the Extend Contracts window, you can extend the end 
date for a contract.

Terminate An active or on hold contract can be terminated using the 
Terminate Contracts window.

Execution Selecting Execution provides you with an overview of a selected 
contract and access to the History, Schedule, Communications, 
and Related Objects tabs. 
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Prerequisites
None

Steps
1. From the Navigator, choose Launch Contracts, click Open. The Oracle 

Contracts window appears. Select the Contract Navigator tab.

2. Select a Contract Group folder and double click to open folder.

3. Right-click a contract and choose Open. The Contract Authoring window 
appears. You are now ready to browse or update the contract. 

2.4 Finding a Contract
Follow this procedure to find a contract when you do not know which group the 
contract is associated with. Using the Search Templates and Contracts window you 
can enter search criteria and execute the search. When the search is completed, a list 
of contracts should appear in the Results region. Select a contract and right click to 
open the contract.

Steps
1. From the Navigator, choose Launch Contracts. The Oracle Contracts window 

appears.

2. From the View menu, select Find. The Search Templates and Contracts window 
appears.

3. Choose your search criteria using one or more of the following fields:

� Contract Number (Modifier cannot be entered it is only populated from the 
LOV)

� Category

� Status

� Start Date/End Date

� Group (within the Select region)

� Party Role: This field must be populated before using the following:

– Intent 

– Party Name 
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– Contact Role

– Email

– Contract Name

4. Click Search.

5. Select your contract from the Results region and right click to open the contract.

Guidelines
To avoid a long query time, you should enter either a contract number, party name, 
or an end date range.

The Email address is available for both sell and buy contracts. It will be enabled 
only if you enter a value in Contact Role otherwise it will remain disabled. 

2.5 Contract Index
You can find and examine various components of a contract by using the Contract 
Index, a tree-style structured navigator. By using the contract index, you can follow, 
access, and understand the relationship of contract parts and better understand the 
context for the contract as a whole.

You can select any part of the contract index tree structure and navigate to any 
appropriate tab, row, or column that has the information that you are looking for.

The Contract Index has five display options, or views. With these views of the 
various contract components, you can see some of the hierarchical relationships and 
certain characteristics of the contract such as parties, line items, articles, and rules. 
The default displays the contract view.

For example, you could choose to view the contract rules as the root node. Oracle 
Contracts Core would then show all of the rules for that particular contract. You 
could then choose to see the association that the rule has to the parties, line items, 
terms, or events of the contract.

2.6 Attachments
The attachment functionality is accessible via a toolbar icon. For more information 
regarding attachments see, Working with Attachments, Oracle Applications User’s 
Guide.

Contracts enables you to attach documents to a contract at the following: 
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�  Contract Header

�  Contract Line

�  Standard Articles

� Communications

These attachments are supported when a contract: 

� Or contract line is copied to a new contract 

� Is renewed 

� Is versioned 

When a contract is versioned the attachments history can also be maintained. 
Maintaining different versions of attachments provides an audit trail which could 
be useful during negotiation. 

A contract is linked to an attachment by Contract ID (ID is the surrogate key for a 
Contract Number and Contract Number Modifier). With this feature, attachments 
are linked to the Contract ID and the major version for the contract. As a result, 
when a contract is versioned, the new version will have attachments that are a copy 
of the attachments attached to the previous version. All the subsequent changes to 
existing attachments or addition of new attachments will be relevant to the current 
version of the contract.

2.7 Contracts Core Functional Components
The components which enable the application are as follows:

2.7.1 Authoring Components Overview
Within the Contracts Authoring window is where the contract is defined. The 
following tabs are used to define the contract:

Header: Displays contract number, version, net price, and so on.

Summary: Provides a quick overview of a contract, including description, class, 
effectivity, and other administrative items.

Parties: A contract can have many parties. Each party is assigned a role such as 
customer or supplier and each role can have a contact. 

Rules: Rules manage various contract processes such as you can use a billing rule to 
determine when a bill should be sent or notification rules regarding a deliverable.
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Adjustments: Enables you to assign a price list to a contract or contract line and to 
make pricing adjustments as needed. Contains all pricing information for the 
contract, at the header and lines / sublines levels. This tab appears only when the 
integration to Pricing is set up.

Line Items: A contract line can be of a certain type, for example, product, license, 
service, and so on.

Articles: Represent the Terms and Conditions for a contract. These may come from 
the library (or repository) of articles, where they can be created and maintained.

Sections: This tab is for supporting organizing articles for the contract preview 
(print) and for viewing articles (terms and conditions via iStore).

2.7.2 Execution Components Overview
After authoring the contract you can find additional information regarding 
versions, history, sales orders, and so on by accessing the Execution tabs:

Overview: Provides a quick overview of contract details such as status, amount, 
category, and so on.

History: Displays history of previous contract versions.

Schedule: Shows scheduled tasks and owners.

Communications: Is used to create and maintain related communications.

Related Objects: (For Sales Contracts) Displays sales order details when a sales 
order has been created from a contract. When a contract has been created from a 
quote, it displays quote information.
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Contract Authoring

This chapter provides the information and procedures from contract creation 
through contract approval. The following topics are covered:

� Creating a Contract

� Authoring a Contract

� Submitting Contract for Approval

3.1 Creating a Contract
This topic group covers the following:

� Creating New contract 

� Creating a Contract From a Template

3.1.1 Creating New Contract
Follow this procedure for creating a new contract. 

Prerequisites
You must have modify access to create a new contract.

Steps
1. From the Navigator - Contracts Manager window, choose Launch Contracts. 

The Oracle Contracts window appears.

2. From the Action Menu, choose New. The Create a New Contract window 
appears.
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3. Select Create a new Contract Manually.

4. Select a Category from the LOV. A category is a contract type associated to a 
contract class. A contract class determines the authoring form used. For 
example, when the class is "Corporate" the Contracts Core authoring form is 
used. Contract categories are seeded. 

5. Click Create. The Contract Authoring window appears. You are now ready to 
author the contract. Proceed to Authoring Contracts.

3.1.2 Creating a Contract From a Template
Use this procedure to create a contract from a template.

Prerequisites
A contract template must be created.

Steps
1. From the Navigator, choose Launch Contracts. The Oracle Contracts window 

appears.

2. From the Action Menu, choose New. The Create a New Contract window 
appears.

3. Select Create a Contract from a Template.

4. Select a template from the LOV. If you need to search for a template then:

a. Click Find.

b. In the Search Templates window enter the search criteria.

c. Select a template.

d. Click Open.

5. Click Create. The Contract Authoring window appears. You are now ready to 
author the contract.

3.2 Authoring a Contract            
The Contracts Authoring window is where you define and modify contracts. You 
can perform the following operations while defining or maintaining a contract:

� Entering General Information
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� Entering Parties

� Choosing Rules

� Selecting a Pricelist

� Selecting Line Items 

� Entering Articles

� Entering a Condition

� Running the Quality Assurance Check

� Submitting for Approval

3.3 Entering General Information
Before you can save a contract a minimal amount of general information must be 
entered. Following Steps 1-9 will enable you to save a contract having minimal 
information. 

 Prerequisites
You must create a contract, see Creating a New Contract Manually.

Steps
1. Navigate to the Contracts Authoring window.

2. Enter the contract number. If Autonumbering is set up, then do not enter a 
contract number. This field populates when you save the record. 

3. Select Buy or Sell for Intent. 

4. Enter an End Date (if not perpetual) or Duration and Period (End Date will 
populate when Duration and Period are entered). See Perpetual Contracts for 
more information.

5. Select Perspective (or accept default).

6. Select the Details subtab.

7. If you want to set the contract to renew automatically, select the Auto Renew 
check box and enter a number in the Number of Days Before Expiration field. 
Note: To renew the contract, you need to run the Contracts Auto Renewal 
concurrent program.

8. Select at least one group name.
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9. If you want the QA run through Concurrent Request instead of online, select 
Submit QA as Concurrent Request?

10. Save your work. 

11. Select the Text tab.

12. Enter a Short Description to help you identify the contract in the repository.

13. Select the Administration subtab.

14. Select Workflow Type, such as "Approve". 

15. Select Workflow Name, such as "APPROVAL PROCESS".

16. If you want the approval through a concurrent request, select Submit as 
Concurrent Request. When submitting for approval with the check box selected, 
an alert is displayed so that you can decide whether the contract can be 
submitted for approval despite QA warnings. 

You can give assign access to groups or individual users from the Access region.

17. Select Type of access (User or Group).

18. Select Group or User Name.

19. Select Level of access (Read or Modify).

20. Save your work.

Guidelines

Perpetual Contracts Contracts enables users to create contracts with end dates 
and without end dates. A contract not having an end date is referred to as a 
“Perpetual Contract”. As such a perpetual contract cannot be extended or renewed, 
however they can be terminated. Under certain conditions, business requirements 
may provide the need for a perpetual contract. 

For example, a company managing customer software licenses may require 
perpetual contract functionality. Because software license agreements last 
indefinitely, there is no reason to apply end dates. Rather the contract effective date 
is open ended with no end date. 

If you want to make the contract perpetual, simply leave the end date field 
blank.The following business rules apply to perpetual contracts:

� If a non-perpetual contract (“Entered” status) is made perpetual (end date 
updated), effective dates on lines will not be updated.
3-4 Oracle Contracts Core User Guide



Entering Parties
� If a perpetual contract is made non-perpetual (end date updated), effective 
dates on lines will not be updated.

� If a non-perpetual contract is renewed/extended as a perpetual contract, lines 
will be made perpetual.

� If the contract is non-perpetual, contract line(s) cannot be extended as 
perpetual.

Attachments You can also use attachments with the Summary tab. For more 
information regarding attachments see, Oracle Applications User’s Guide, Working 
with Attachments. 

Using Save As Template At any time you can save an incomplete contract as a 
template, using Save as Template from the Actions menu.

QA Check You can enter condition types and actions, quality check a contract or 
submit it for approval using the buttons at the bottom of the window. At any time, 
you can check if your contract passes Quality Assurance. The result of the on-line 
Quality Assurance check is displayed as soon as it completes. There is no need to 
run the Quality Assurance before you submit the contract for approval, since the 
Quality Assurance is automatically run before submitting for approval.

3.4 Entering Parties
From the Parties tab, you can identify the legal parties for the contract. You can also 
enter individuals involved with the creation and management of the contract as 
contacts for the parties. Sales contacts can also be entered. The information you can 
enter depends on the category and intent. This section covers the following topics:

� Roles and Contact Sources

� New Roles

� Party and Customer Account Merge Overview

� Entering a Party and Contact

3.4.1 Roles and Contact Sources
A contract is an agreement between at least two parties. Each party assumes a role 
in relation to the contract, such as the vendor or the customer. The setup of roles 
differentiates between sell and buy contracts. You can add two or more parties 
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when authoring a contract and you can define the party roles and define the sources 
from within Oracle Applications for validating parties.

For example, if you sell goods or services, then you are the vendor and your 
customer may already exist in your customer database (source) as a regular 
customer.

If you buy goods and services, then you are the customer and your vendor may 
already exist in your vendor database (source). Even though you are the customer 
in this contract, you don’t want to register as a customer in your customer database 
just to be available as the customer in the contract.

In both contracts you have a customer and a vendor each. In one contract you are 
the customer, in the other you are the vendor.

3.4.2 New Roles
In a contract, a role can only be selected if the following conditions are met:

� The category you choose permits the use of that role.

� The role has a valid source. Make sure that the source has a valid date range, 
the intent (sell or buy) matches your contract, and that the source has values.

Once you have defined a new party role or contact role using Define Categories, 
you can select them in the Sources window, where you can assign the sources.

A new party role or contact role will only appear in your contract, if the following 
conditions are all met:

� The role or contact role is defined as a lookup code with a current effective date.

� The role or contact role has a current effective date in the Sources window.

� The role or contact role has a source assigned with a current effective date and 
the right intent (buy or sell).

� The source for the role and intent contains at least one value.

� The party role may be needed (for Rules) as well.

3.4.3 Party and Customer Account Merge Overview
Oracle Contracts subscribes to the Trading Community Architecture (TCA) engine 
in order to utilize the party merge functionality. The Trading Community 
Architecture enables the requirement to merge one party into another when 
duplicate parties have been identified. 
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The Party Merge functionality within the TCA is specifically designed to eliminate 
duplicate data in the Registry layer in order to keep the database accurate. Party 
information is merged to provide a consolidated view. 

Oracle Contracts registration of the entities that reference parties and defining the 
merge procedure allow users to utilize the merge functionality. A batch program 
runs to determine the duplicate party records and merge them accordingly. 

3.4.4 Entering a Party and Contact

Prerequisites
You cannot enter new customers from the Authoring window. When you need to 
add a new customer or a supplier, these must be defined in Oracle Applications.

Steps 
1. Navigate to the Contracts Authoring window and select the Parties tab.

2. Select a Role, such as Customer or Vendor.

3. Select a Name. 

4. If you want to add "Party Known As" as another identifier for the party, enter 
that name. 

5. If you want to add "Contract Alias" enter the alias the party uses for the 
contract. 

6. From the Party Contacts region, select a Contact.

7. Enter a sequence. The sequence determines the order the contacts should 
appear.

8. Select a Name for the contact.

9. Repeat this procedure for adding other party to contract.

10. Save your work.

3.5 Choosing Rules 
This topic group explains rules and how they are used in a contract. Since rules 
trigger many functional processes within contracts, it is essential that they be clearly 
understood. This section covers the following topics:

� What a Rule Does
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� Rule Groups

� Tracking Deliverables with Rules

� Renewal Rules

� Conditions and Rules

� Object and Subject

� Quality Assurance and Rules

� Choosing Rules for a Contract Line

3.5.1 What a Rule Does
When you enter an article in a contract, that article represents the terms and 
conditions expressed as text. Rules can also be considered as contract terms and 
conditions with the addition of computer-readable formatting that cause Oracle 
Contracts Core to take action based on the information. When you enter a rule for 
an article you can initiate functions within the application. 

For example, an article states that a confirmation letter must be sent within three 
days of contract signing. When this information is entered as a rule, a notification 
for the confirmation letter is generated.

Oracle Contracts Core contains seeded rules. Rules can be put into use in three 
different places:

� Contract header

� Contract line

� Article sets

Only the seeded rules are supported. You should not create your segments using 
the OKC Rule Developer DF development tool. If you are able to create new rules 
and make it work, subsequent patches could wipe them out.

3.5.2 Rule Groups
A rule group contains one or many rules. Rules collect one or many related pieces of 
information. Rules are stored in a formatted way as opposed to free text like articles.

Your company can choose to assemble rule groups and make some rules optional. 
Once you have selected a rule group, you can see if the rules contained are optional. 
Assign rule groups to your contracts according to your business procedures.Rules 
with similar characteristics are grouped so that you can easily reference and access 
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them. For example, create a rule group for billing which would group together rule 
types such as Bill-To, Schedule Billing, and Payment Terms.

You can save incomplete data, but all required rules have to be complete to pass 
quality assurance.

3.5.3 Tracking Deliverables with Rules
Rules capture additional information you want to store for a contract. You can 
group rules into rule groups that help to enforce business processes and company 
standards.

3.5.3.1 Notify Rules
Notify rules are a part of the "Notify Rule Group". Notify rules indicate that some 
deliverable is due at a future date or time that is not known at the time of authoring 
the contract. For example, "product" documentation must be provided within 30 
days of contract "signing." Rule groups that contain notify rules also contain a 
notification rule so that you can create tasks for the notify rules. You can view notify 
rules in the task manager.

You can use the following types of time in a notify rule:

� Absolute: The point in time is defined by absolute values and is expressed as a 
date and time value. An example is January 15 at 9 a.m.

� Conditional: The point in time is when something happens or after something 
happens. Examples include "10 days after contract signing" and "upon contract 
expiration." A notify rule can also be based upon contingent events, such as 
"injury accident" or "earthquake."

� Generic: The point in time is a day of the month or day of the week. Examples 
include "every first Monday at 10:00 a.m." and "the third Wednesday of June."

� Recurring: The point in time that reoccurs at intervals, such as every 6 months 
or every 30 days.

You can view scheduled events for a contract in the contract navigator. If you 
created tasks, then you can also use the administration windows in the Task 
Manager.

3.5.4 Renewal Rules
You can use the Renewal rule group to determine the behavior of contracts and 
lines when a contract is renewed. 
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At the contract level you can choose between the following options: 

� Active contract: The renewed contract is automatically approved. 

� Do not renew: The contract cannot be renewed. 

� Notify Salesrep: The renewed contract is in entered status and the salesrep is 
notified, to review the contract and negotiate the terms and conditions before 
submitting for approval. To find a Renew Contract notification in your Inbox, 
click the Find button in the Inbox region of the Launchpad tab window. Select 
"Open" for Status and for the Notification Type select "Contract Alert" for 
notifications identifying renewed contracts. 

� Submit for Approval: The renewed contract is in entered status, the contract is 
automatically submitted for approval and the salesrep is notified. 

At the contract line you can choose between the following options:

� Do not renew: The renewal process does not renew this line when renewing the 
contract.

� Keep duration: The renewal process does not adjust the effective date range of 
the line if the renewed contract has a longer duration than the originating 
contract.

� Full duration: The renewal process adjusts the line duration to the duration 
specified in the contract header.

For each line you can override the renewal rule type. For example, while the entire 
contract may specify that all lines are adjusted to full duration, a rule on the line 
level may specify to exclude a certain line from the renewal process.

3.5.5 Conditions and Rules
You can use conditions and rules together or you can use each component 
individually. 

A condition is part of the events concept: 

� An event is the combination of actions, condition lines and outcomes. 

� When combined with a rule, a condition does not require an outcome. 

� Condition lines are always optional. 

With conditions you can capture contract events, like the signing or expiration of a 
contract. You can use condition lines to filter, if an outcome is executed. For 
3-10 Oracle Contracts Core User Guide



Choosing Rules
example, you can define that a quote is automatically created 5 days prior to the 
expiration of a contract, if the contract total does not exceed $50,000.00. 

With the notification rule, you can schedule a generic notification, that does not use 
a condition like the expiration or the initiation of a change request. For example, 
You can define that the project leader is notified every other week to schedule a 
status meeting for the following Friday. 

Using rules and conditions together, you can base the notification on conditions. For 
example, You can send a notification to the project manager, each time a change 
request is initiated. The notification is not sent, if it was initiated by the project 
manager. In this example, you would integrate a contract specific condition in the 
notification rule. The condition would identify the change request initiation and 
filter, if the requester of the change request is the project manager herself. 

3.5.6 Object and Subject
When you define categories or create a contract, you may encounter situations, 
where the role of a contract party may be obvious. However, the system may not be 
able to identify which of the parties or party roles should be displayed in a list of 
values. 

For example where you have: 

� Multiple parties for a specific role (more than one customer in a syndication 
agreement) 

� Multiple roles, that only have slight differences (customer and customer agent) 

The subject is the acting party, the object is the party being acted upon. For example, 
the billing rule would need to know who (the subject) bills whom (the object). 

The concept of object/subject is considered in two situations: 

� Defining a category 

� When authoring a contract and adding/changing rules 

Note: If the condition lines do not offer you the attributes you need for 
filtering, then you can use the process definition to register a PL/SQL 
function to return true or false. For more information on registering a 
function, see Oracle Contracts Core Implementation Guide, Defining a 
Process. 
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Not all of the rules need the concept. When you enter a rule, where none of the 
parties is ever displayed in a list of values, the subject/object concept is irrelevant 
such as the currency rule group, notify rule group, renewal rule group, and so on. 
Therefore you cannot enter a object or subject in the fields for such rules. 

When you assign rules to a category, you may have to add the roles to the setup, 
when the rule group requires it. If that setup step is missing, then the authoring 
form will notify you of the incomplete setup of the category, when you try to use 
the rule group in question. 

For the example given above, when you add the billing rule to a category, you 
would have to identify that the customer role and not the customer agent role 
should be subject of the billing rule group. 

When you author a contract, you may have more than one customer, for example 
when you record the contract for a syndicate. In that case, the party roles field 
allows you to identify, to which of the customers the invoice is sent. Once you have 
identified the right customer, then you can select from correct billing addresses. 

3.5.7 Quality Assurance and Rules
Each rule can consist of one or more fields. One or more fields can be required 
entries. You can only add rule groups and not single rules to a contract. Quality 
assurance enforces required fields. The quality assurance checklist check a contract 
to help ensure specific items have been completed. You can create your own quality 
checks by defining a QA Checklist. See Oracle Contracts Core Implementation Guide, 
Defining a Quality Assurance Checklist.

The optional check box in the rule groups impacts the required fields of a rule in the 
following ways: 

� If you make a rule in a rule group mandatory, then the required fields of a rule 
must be entered.

� If you make a rule in a rule group mandatory, but there are no required fields, 
then Quality Assurance passes.

� If you make a rule in a rule group optional, with all fields non-required, then 
Quality Assurance passes.

Note: You need to identify the object and subject, even if there is only 
one eligible candidate. 
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� If you make a rule in a rule group optional, then the required items are only 
enforced if at least one field of the rule was entered. If you don’t enter anything 
for a rule, the mandatory fields are not enforced. You will experience this only 
in very exceptional cases.

In addition to rules with non-required fields, Quality Assurance can enforce 
dependencies or alternatives. For example, in a prepayment rule, you either have to 
enter an amount or you have to enter a percentage, but neither of the fields are 
mandatory. In this case, the Quality Assurance check will result in an explanation of 
why the rule did not pass.

3.5.8 Choosing Rules for a Contract Line
Use this procedure to add, edit, and delete rules at the contract header or line level 
while authoring a contract.

Prerequisites
To access a Rule Group from the Contracts Authoring window, it must be included 
the Rule Group in the category definition. More than one rule group can be 
included in a category.

Steps
1. Navigate to the Contracts Authoring window and select the Rules tab.

2. Select a Rule Group. Rules associated with a selected Rule Group appear in the 
Rule region (below Rule Group). To distinguish rule groups that have the same 
name, you can enter a comment or description for each rule group. Depending 
on the rule group, you may have to enter an object and/or subject. See Object 
and Subject. 

3. Select a Rule. If the Required check box (read only) is selected, this indicates the 
rule is required for that Rule Group. If the Entered check box (read only) is 
selected, this indicates Rule Detail Values were entered for that rule. 

4. Enter a Value for the Rule Detail when the Required check box (read only) is 
selected.

5. Enter values as needed for other Rule Details.

6. Repeat this procedure for adding other rule groups to a contract.

7. Save your work.
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Guidelines
When you select a rule group in your contract all rules of that group are 
automatically copied into your contract. For some rules, sources are provided for 
each intent (buy or sell). You can modify the rule type source. You should not 
remove an existing source definition.

3.6 Selecting a Pricelist
This topic group covers the following:

� Integration Features

� Business Rules for Pricing

� Pricing Date

� Selecting a Pricelist for Contract

3.6.1 Integration Features
Integration with Oracle Pricing enhances Contracts pricing capabilities. Oracle 
Contracts can price contracts using various discounts and promotions that are 
offered for the items specified in the contract lines. Also, header level discounts 
available for orders can be made available through contracts as well.

Oracle Contracts can price contracts using the various discounts, promotions, and 
so on that may be offered for the items specified in the contract lines. Also, header 
level discounts available for orders should be made available through contracts as 
well.

Pricing Contract Lines
The price of all the items specified in contract lines for which prices have been 
specified in Oracle Pricing, can be obtained with this integration. This way, there is 
one source price list when using Order Management, Order Capture, or Oracle 
Contracts. You can specify the price lists for the items in a company’s business and 
use them from all three applications. The prices for all the priced lines in contract 
can be calculated after application of all the discounts and surcharges defined in the 
system for the defined item on the unit price specified in the price list. 

Note: If the Adjustments tab does not appear, then the integration 
is not enabled.
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To achieve this, you are allowed to choose a price list at the line level. If nothing is 
specified, the price list, if any at the header level will be used, or Oracle Pricing will 
return the best price available if no price list is specified at any level. The discounts 
and surcharges will be qualified based on other information entered in the 
hierarchy of lines for the priced item line. The qualifying adjustments (discounts, 
surcharges, promotions, and so on) can be setup in Oracle Pricing as either 
automatic or manual. Adjustments can be applied automatically to the unit price.

Pricing Complete Contract
After a contract has been authored, you can get header level adjustments. The 
discounts and surcharges will be qualified based on information specified at header 
level in the contract. The qualifying adjustments (discounts, surcharges, 
promotions, and so on) can be setup in Oracle Pricing as either automatic or 
manual. Adjustments can be automatically applied to the unit price. Thus the final 
price shown at the header level will be a roll up of the prices at the line level, 
adjusted with header level adjustments

Viewing Pricing Information in Contracts
You can view price lists applied at various levels and also the adjustments that were 
used to reach at the final price at various levels. To accomplish this, the 
Adjustments tab is part of the contracts Authoring form. You can assign as well as 
view information related to pricing of the Contract at various levels.

Repricing Contract Lines and Headers
You can reprice a line or the whole contract if some qualifying attributes change and 
when changing attributes might affect the end price of the line or the header. This 
enables you to make use of all the new discounts and promotions that may have 
been added between the last pricing to this repricing. Also, if a priced line gets 
deleted from the contract, Pricing can recalculate its affect on Header level 
adjustments.

Repricing for a priced line will automatically occur if any line in the same hierarchy, 
above the priced line is updated. The roll up price at the header will reflect this 
change in price of line.

Support for Price Lists with Price Breaks
Oracle Contracts supports pricing of items that belong to a price list with price 
breaks. A Price Break is a pricing modifier type that applies a variable discount or 
surcharge to a Price request line based on meeting conditions of the price break. A 
Price break adjustment consists of a header and the corresponding child lines. A 
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price break can be of Point or Range type and involve different adjustment 
calculation methods.

Oracle Contracts also supports price break adjustments. This allows manual 
override of automatic and manual price break adjustments. The Price Break Details 
(Related Lines) form allows users to view or override the current price break details.

Manual Adjustments
After pricing an item, based on unit price and adjustments defined in the system, 
you can manually update the final price of the item. You can still maintain control 
on what the final price should be for an item. This can be done by creating a manual 
adjustment to update the price.

Pricing During Copy and Renew
When you copy a contract, the pricing related information is also copied to the new 
contract. For renew, the contract is repriced.

3.6.2 Business Rules for Pricing

Line Styles
� The same line style cannot be both a Priced Item, and basis for another item’s 

price.

� The same line style can be a Priced Item and ‘Priced’.

� In a hierarchy of lines only one line can be the Priced Item. 

� For a line style hierarchy to be priced, there should be a line style flagged as 
priced and one line style flagged as priced item.

� Priced line style should be below or same level as PI or BPI in the hierarchy of 
line styles.

� In case of recursive line style, the first occurrence of P,PI or BPI will hold this 
special meaning, in all further occurrences, the value of these flags will always 
be treated equal to ‘N’. 

Contracts Authoring Form
� Price lists and modifier selection in a contract will be limited to the currency 

specified in the contract.

� You will be able to assign only one price list to a Contract header.
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� If a price list is present only at the header level, then Oracle Pricing will use it 
for pricing all the lines in the contract. If the header price list can’t be used to 
price a contract line in question, based on profile option ‘Allow Automatic Price 
List Assignment’ setup, Pricing will use lowest precedence price list that 
qualifies for line or show a WARNING message, stating that the contract line 
could not be priced

� You will be able to manually update only those price adjustments and 
calculations which have been derived from veritable modifiers and overridable 
price lists. 

3.6.3 Pricing Date
The Pricing Date is the effective date that forms the basis to price products and 
services contracted. The main business need is the flexibility to price products and 
services based on different dates depending on when the contract will be 
negotiated. For contracts with products and services scheduled for a future period, 
it is useful to provide a mechanism to revise the prices as appropriate based on the 
business policies and practices.

The Pricing Date field is found in the Adjustments tab for header level pricing and 
also in the Adjustments subtab for line level pricing. This field is intended for the 
contract administrator or sales representative to accurately price contracts.

Based on the date entered in this field, the application makes a call to Advanced 
Pricing to obtain the price for the product based on the Price List and the Date. If no 
price exists for the product for the given Price List on the specified date, the system 
returns an error message.

3.6.3.1 Business Scenario
A Sales contract was created with an effective of duration of one year starting 
01-Jan-2002. At the end of the year, the contract will be renewed for another year 
starting 01-Jan-2003. Beginning 2003, the company will revise its price lists for all 
products and services. The contract does not specify the prices to be charged in case 
of renewals.

In this scenario, when the contract is renewed, the system prices the products and 
services as of the system date of renewal. 
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Assuming the renewal is carried out prior to the actual start date of the contract, the 
customer may potentially be overcharged or undercharged depending on the 
revised price directions.

The users may enter a Pricing Date for the products and services and to have them 
priced appropriately. So, in this scenario, the price for the renewed contract will be 
as of 01-Jan-2003. This provides a more accurate representation of the true value of 
the Contract.

3.6.3.2 Business Rules
The following business rules are applicable when using Pricing Date:

� Pricing Date is not mandatory. If no pricing date is provided, the system will 
use the "System date" to price the products and services. The system will 
update the Pricing Date at the Header with the System Date.

� Header date cascades to lines. If the Pricing Date is provided only at the Header 
level, the system will use this date to price all Line items.

� Line level Pricing Date overrides header. If you provide Pricing Date at the line 
level, the system will disregard the header level date and consider this for 
pricing the line. 

� Pricing Date at a line level cannot exceed the End Date of the Line. Similarly the 
Pricing Date at the header cannot be greater than the End Date of the Contract. 
However, no restrictions apply with respect to Start Date of the Contract or the 
lines. A pricing date may be earlier than the Start Date of the Contract or the 
Line.

� Copy and Renew functions of a contract will nullify the pricing dates at both 
the header and line levels. You will have to provide pricing dates on the copied 
or renewed contracts manually to price the lines.

3.6.4 Selecting a Pricelist for a Contract

Prerequisites
Create and Define a contract.

Note: The "System Date" is the date on which the transaction is 
carried out in the Contracts Application, also known as "Current 
Date".
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Steps
1. From the Contracts Authoring window, select the Adjustments tab.

2. If a rule is tied to a modifier (during modifier setup), from the Contracts 
Authoring form, click the Rules tab.

3. Select Rule Group (e.g. Billing)

4. Enter Rule Details information.

5. Click Adjustments tab. This shows the whole contract in tree form on left hand 
side (LHS). 

6. Perform one of the following:

� If you want the header priced, select the header node on right hand side 
(RHS). This will bring up the corresponding pricing detail already defined 
for this contract header on RHS. 

� If you want the line priced, select the line node on RHS. This will bring up 
the corresponding pricing detail already defined for this contract line on 
RHS.

7. Choose a pricelist from the LOV and click OK. An LOV of active pricelists will 
show up. This will unassign any adjustments that the user might have 
previously applied to the header and clean up the modifier details. 

8. If you need to adjust the price, Click the LOV in the Adjustment field. The 
Manual Adjustments window opens.

9. Select an adjustment and click OK.

10. Select a Reason from the LOV and click OK (optional).

11. Enter text as necessary (optional).

12.  Click Calculate. The final list will be saved and the calculation details will be 
shown. Also when you navigate from this tab, the chosen price list will be 
applied automatically. The Calculate option should also be used when you have 
made changes to the quantity of a line item or deleted line items. 

3.7 Selecting Line Items
A contract is composed of lines of text. Control the type of information that can be 
entered on a particular line by defining a line style. The line style sets input 
requirements and sets up the lists of values to choose from in a contract line during 
contract authoring.
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This section covers the following information:

� Top Line

� Sublines

� Priced Line Styles

� Recursive Line Style

� Line Types and Item Source

� Priced Lines and the Pricing Rule

� Inventory Item Restriction

� Selecting a Line Item

� Using Oracle Configurator

3.7.1 Top Line
Each contract has one or more contract lines. A contract line can be a simple priced 
item line or can consist of several layers of lines and contract items. The most 
general and least detailed line in a contract is called the top line. You can break a top 
line into sublines and multiple contract items to provide a rich level of detail.

To include a top line and its details in a contract, you must include it in the category 
definition. For service contracts, you can define a top line style to be eligible for 
entitlement and invoicing. You define a new line style by selecting the plus sign on 
the top mode.

3.7.2 Sublines
Use lines and sublines to group and categorize goods and services. The specific 
goods and services are referenced from your inventory or product catalog as 
contract items. You can use sublines to provide additional detail about the delivery 
of the contract item. For example, a line for a service product includes a subline that 
defines the level of service contracted for that product. A line that represents a 
licensed product includes a subline that identifies where the product is deployed.

If the line style is a Covered Product, the list of values of Item Name field in the 
Subline tab shows only the products from Install Base for the party specified in your 
contract. To get the list of values of the Item Name you need to enter a value for the 
Customer Account rule of Billing rule group. 
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3.7.3 Priced Line Styles
When creating a line style, you can define it as being a priced line style. You can 
enter a quantity, unit of measure, and unit price. The line automatically calculates 
the extended price and net price. You can enter adjustments to automatically 
decrease or increase the net price. This feature is found at both the line and subline 
levels. See the following table for examples:

For each hierarchical path in a line style, you can only price once. You can have 
multiple prices on the same level in a hierarchy.

For example, assume a line style hierarchy such as the following:

Figure 3–1 Line Style Hierarchy

Scenario Extended Price Adjustment% Net Price

Initial value $2,400.00 0 $2,400.00

Offer 10% discount $2,400.00 10 $2,160.00

Add 10% surcharge $2,400.00 -10 $2,640.00
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1. You can mark Items 1.1.1.3, Item 1.1.2, Item 1.2 and item 1.3.2 as priced items. 
None of these priced items is a parent or child of another priced item.

2. When you mark the line style for Item 1 at the top line as a priced item, all other 
dependent lines have their price tag removed.

3. Both Item 1.3.2 and Item 1.3.1 can be priced in this example.

3.7.4 Recursive Line Style
Recursive line style allows users to define lines and sub-lines of the same type and 
with the same source. This is useful when the number of levels that will be needed 
in a contract are unknown. 

For example a project with several tasks, these tasks can be a line style. Depending 
on the project there maybe several tasks and sub-tasks:

Top Level: Task 1 - Clean Area

Sub-line Task 2 - Ship the Material

Sub-line Task 3 - Prepare Installation

Sub-line Task 4 - Install the Product

In the example each task depends on a previous task completion. The project may 
require tasks with 2 sub-tasks, or 3, or 4 and so on. Because the depth level of 
sub-lines is unknown the user can define the line style as recursive. In the contract 
authoring form many levels can be entered for each line of this style.

3.7.4.1 Pricing and Recursive Line Style
Due to the complexity of the recursive line, only one level can be priced. Only the 
top level can be priced. In the setup the user cannot specify which level within the 
recursive line to price. All the others are used to document the task dependencies 
only. 

For example, if you define "Product" as a top line as priced and recursive, in the 
contract authoring form then the following names for the top line and sub-lines 
maybe displayed:

Top Line: PC Computer (inventory item) $2,000.00

Sub-line 1: Terminal (inventory item) not priced

Sub-line 2: Cables (inventory item) not priced

Sub-line 3: Mouse (inventory item) not priced
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For information regarding defining price lists including their limitations to only 
work with inventory items, see the Oracle Pricing User’s Guide.

3.7.5 Line Types and Item Source
For each level in the line style hierarchy, you select a line type and the item source. 
The item source defines the list of values available when authoring a contract that 
contains the line style.

The line styles that can be selected are based on the contract category and line style 
hierarchy.

One special line type is called "Free Format" and is used to enter any text 
description. It does not include an item source. The item source indicates, where 
you can add values to the selection. For example, the source Consulting refers to 
items in your inventory items with the item type Consulting. Similarly, you can add 
items for the source Media Pack, Self Serve Training or Training Line. The source 
System Item refers to all items in your inventory. 

3.7.6 Priced Lines and the Pricing Rule
Before you enter priced lines in your contract, define the pricing rule group for the 
contract header or contract line. The pricing rule group identifies the price list to be 
used for your priced items. 

After you identify the price list and when you add priced lines to your contract; the 
list price of the item is retrieved. Based on the quantity you enter on the line, the 
extended price is calculated. This extended price can be overridden in the 
negotiated price column to account for contractual agreements.

3.7.7 Inventory Item Restriction
The inventory items list of values is restricted by the organization that is available 
to the contract. When a contract is entered, the organization ID is obtained from the 
multi-organization profile option value. The inventory organization value is 
obtained from the Oracle Order Entry system parameters. 

Note: If the integration to Oracle Advanced Pricing is set up, then 
the Pricing Rule is not used.
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You cannot enter a new item into the individual inventory organizations directly. To 
enter a new item in Oracle Inventory, you enter the item into the master 
organization. Then you copy the item to the individual inventory organizations.

3.7.8 Selecting a Line Item
From the Line Items tab, you can detail all the contract line items, which are the 
contract deliverables and relevant items. The Line Items tab has three subtabs: 
Sublines, Rules, and, Parties. You can use the subtabs to add and exclude data 
specific to a line. Use this procedure to enter details for a line.

Steps
1. Navigate to the Contracts Authoring window and select the Line Items tab.

2. Select the line style.

3. Enter a number for the display sequence.

4. Depending on the line style definition, you may enter the Name or select a 
name from the list of values.

5. Enter a quantity.

6. Enter the unit of measure.

7. If a list price is defined for the item in the price list, then the unit price is 
retrieved and displayed. Otherwise, you can enter the unit price. The extended 
price is automatically calculated from the quantity times the unit price. The 
calculated value also populates the Net Price field.

8. If you want to adjust the net price enter a value in the Adj% field. Entering a 
positive value results in a decrease in the net price (i.e for a discount). Entering 
a negative value results in an increase in the net price (i.e. for a surcharge). 

Note: If your line item is priced at the top level, you can enter 
quantity, unit of measure and price information. You can override the 
contract level price list by choosing a price list in the Rules subtab.
3-24 Oracle Contracts Core User Guide



Selecting Line Items
9. Optionally, depending on the line type you selected, use the Sublines tab to 
enter more detail in the sublines.

You can enter sublines for those lines defined to contain sublines in the line 
style hierarchy. This window allows you to view and edit the hierarchy at any 
level. Navigate through levels by using the Drill Up and Drill Down buttons.

10. Enter rules on lines the same way rules are entered on the contract.

11. Use the Parties tab to add line specific information that is not valid for the 
entire contract. Entering a party in a subline is similar to entering party 
information for the contract.

12. Repeat this procedure for adding additional line items to a contract.

Guidelines

Attachments You can also use attachments with the Line Items tab. For more 
information regarding attachments see, Oracle Applications User’s Guide, Working 
with Attachments. 

3.7.9 Using Oracle Configurator
This section contains the following topics:

� Oracle Configurator Overview

� Functional Flow with Oracle Configurator

� Invoking Oracle Configurator

Note: The Action menu has a menu item “Update Negotiated Price”. 
When the menu item displays Update Negotiated Price ON, the 
negotiated price will default to the extended price and any further 
changes in the extended price will reflect in the negotiated price. The 
user can override the negotiated price later. When the menu item 
shows Update Negotiated Price OFF the negotiated price will not 
change if the extended price changes. This menu item is disabled 
when integration with Oracle Pricing is used.
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3.7.9.1 Oracle Configurator Overview
Configurator helps you to configure custom items. A configured item corresponds 
to a base model and a specific list of options. The following terms and definitions 
are associated with Configurator:

� Configuration is a specific set of specifications for a product, resulting from 
selections made in an Oracle runtime configurator. 

� Model refers to the entire hierarchal tree view of all the data required for 
configurations, including model structure variables such as resources and 
totals, and elements in support of intermediary rules. May consist of BOM 
items. 

� Option Class refers to a group of related items.

� Option Item is a non-mandatory item component in an option class or model 
bill of material.

� Bill of Materials (BOM) is a list of component items associated with a parent 
item (assembly) and information about how each item relates to the parent 
item.

An example of a Configuration:

Model - Envoy Laptop Computer 8100

Option Class - Memory

Option Item - 128 MB RAM

Option Item - 256 MB RAM

Option Class - Hard Drive 

Option Item - 12GB Hard Drive

Option Item - 18 GB Hard Drive

Option Item - 25 GB Hard Drive

Option Class - Software

Option Item - Word processing

Option Item - Spreadsheet

In Oracle applications configurable items can be:
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� Assemble to Order (ATO)/Bill of Material (BOM) models: The selected 
configuration is assembled and shipped to a customer. For example a PC is built 
and shipped as per configuration of 25 MB RAM and 10GB of disk space.

� Pick to Order (PTO)/BOM models: The selected configuration is picked and 
shipped to the customer. For example a PC, monitor, keyboard, and mouse are 
picked and shipped to the customer.

Configurable items leverage ATO/PTO data that exists in Oracle Inventory and 
BOM imported into Configurator. ATO/PTO BOM models are created in Bill of 
Material using items created in Inventory. 

References
Oracle Configurator Developer User’s Guide

3.7.9.2 Functional Flow with Oracle Configurator
From the Contracts Authoring form you enter the base model from the Lines tab. A 
recursive, priced line style must be selected before entering the model item. The line 
style must be set as Recursive, Priced, and Item to Price using the Line Styles 
window. This line style enables you to price at every level, e.g. both top line and 
subline. The Contracts Authoring form recognizes this and enables "Configure 
Item" from the Action menu. The "Configure Item" menu item is only enabled in the 
Lines tab for model items. When you select "Configure Item", the Oracle 
Configurator window appears.

The options are selected from the Oracle Configurator window. When the selection 
of options is complete, you can click "Done" or "Cancel" and return back to the 
Contracts Authoring form. 

The Line Items tab displays the configured items along with prices based on a 
specific price list. You can use the "Drill Down" features to view the items and 
options from the Line Items tab. If you need to make changes, then navigate to the 
top line and select Configure Item from the Action menu. 

3.7.9.3 Invoking Oracle Configurator

Prerequisites

� From the Line Styles window set up a line style having Recursive, Priced, and 
Item to Price selected from the appropriate check boxes. 

� From the Define Category window associate the line style to the Category 
required for the contract. 
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� When a price list is set up for a model item, all items under available options 
must be priced first. If not, the Pricing system returns an error.

Steps

1. From the Oracle Contracts window, navigate to Tools > New. The Create a New 
Contract window appears.

2. Select a Category which enables you to configure a model item.

3. Click Create.

4. Enter Summary information.

5. If a specific pricelist is required before configuration, select Adjustments tab.

6. Select the Pricelist.

7. Click the Line Items tab.

8. Select a Line Style. (See Prerequisites for setup)

9. Enter the Sequence.

10. Select the Name for the model item that has been configured in the 
Configurator module.

11. Enter Quantity and select UOM. The system will populate the pricing fields.

12. Navigate to Actions > Configure Item. The Oracle Configurator window 
appears. 

13. Select an Option Class from the Left Side of the window.

14. Select one or more options from the Option Class.

15. Repeat steps 13 and 14 for additional options.

16. Click the button in the lower left to calculate the Total Price.

17. Select Done. A new contract line is created as the top line. This new line stores 
the roll-up price for the contract. If you select Cancel, the configuration is 
cancelled.

18. Select Sublines tab.

19. Click Drill Down to view the sublines for the configuration.

20. Click Drill Down to view the Option classes and options for the configuration.

21. If you need to add more model items, select the model item in a new top line.
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22. Repeat this procedure for additional items. 

3.8 Entering Articles
A contract article is the text that describes and details the terms and conditions that 
are attached to a contract. The following topics are covered:

� Library of Articles

� Entering a Standard Article

� Entering a Non-Standard Article by copying a Standard Article

� Entering a Non-Standard Article

3.8.1 Library of Articles
The library of articles contains standard articles that can be referenced or copied 
into contracts. There are two different types of articles: 

� Standard articles are referenced from a library of articles. The text of standard 
articles cannot be changed. You still may add variation to an article in a 
contract. You can assign releases to articles. When you insert an article into a 
contract, the application chooses the current release. If you assign 
incompatibilities to a standard article, then the Quality Assurance check detects 
any incompatible articles in your contract.

� Nonstandard articles are specific to the individual contract. They are either 
written by the author of the contract or copied from the library of articles and 
modified.

The standard articles are organized into article sets. Use article sets to organize 
articles logically and make them easier to include in contracts. You can then drill 
down to articles from the sets. You can assign price types and categories to article 
sets. When you author a contract, the list of values for the standard articles are 
filtered by the assigned price types and categories. You can translate article sets into 
rules. When an article set is referenced or copied into a contract, the associated rules 
are also copied into the contract. 

Whenever you use a standard article within a contract, all rules that have been 
associated with that article are copied (compatible to your contract category) into 
that contract where they can be modified. You can define rule groups during the 
initial setup of the standard article set. Rule groups are not copied when individual 
articles are selected for reference or copy.
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3.8.2 Entering a Standard Article
Use this procedure to reference a standard article or article set while authoring a 
contract.

Reference
Oracle Contracts Core Implementation Guide, Defining the Library of Articles: Article 
Comparison, Creating a New Article, Editing an Article, and Modifying an Article Set

Prerequisites
An Article Set should be created containing the standard article you want to 
reference.

Steps
1. Navigate to the Contracts Authoring window.

2. In the Articles tab, leave the Standard check box selected. 

3. In the Name field, select an article set.

4. Select the article. Optionally, double-click the article set to select only one 
article. If you know your article, then you can type in fragments of the article to 
reduce the list of values matching your search criteria. This second method 
bypasses the navigation through article sets. 

5. Click Reference.

6. Optionally, click Show Text to modify the text.

7. Save your work.

Guidelines
When selecting an article set, the rule groups defined for that set are copied into the 
contract. When selecting an individual article, rules are not copied.

Attachments You can also use attachments with the Articles tab. For more 
information regarding attachments see, Oracle Applications User’s Guide, Working 
with Attachments. 

3.8.3 Entering a Non-Standard Article by Copying a Standard Article
Use this procedure to copy an existing standard article and modify it.
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Steps
1. Navigate to the Contracts Authoring window.

2. In the Articles tab, leave the Standard check box selected.

3. In the Name field, select an article set.

4. Select the article. Optionally, double-click the article set to select only one 
article. If you know your article, then you can type in fragments of the article to 
reduce the list of values matching your search criteria. This second method 
bypasses the navigation through article sets. 

5. Click Copy. The standard flag is automatically unchecked when you choose to 
copy an article instead of referencing it.

6. Optionally, click Show Text to modify the text.

7. Save your work.

3.8.4 Entering a Non-Standard Article
Use this procedure to create a nonstandard article.

Prerequisites
A contract must be created, even if it is only in its initial authoring stages.

Steps
1. Navigate to the Contracts Authoring window.

2. In the Articles tab, clear the Standard check box.

3. Enter a name to describe your non-standard article.

4. Select the Subject.

5. Click Show Text and enter the article text.

6. Save your work.

3.9 Entering a Condition     
This section covers the following topics:

� Contract Events

� Query a Condition
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� Copying a Condition template

� Creating a Contract-Specific Condition

3.9.1 Contract Events
Use events to automatically initiate actions such as creating a service request, 
sending a notification, and creating a task. Events occur as a result of something 
happening or before an upcoming event.

In other words, an event acts upon phrases such as:

� When this happens, do something

� At a certain point in time, something happens

The “when something happens” or “at a certain point in time” are actions, and “do 
something” is an outcome. The action can be qualified by conditions. For example, it 
may not be whenever something happens, but whenever something happens and 
some conditions are met. In summary, events are composed of actions, conditions, 
and outcomes.

Events allows synchronous and asynchronous processing. The asynchronous 
processing takes advantage of the advanced queuing method. That is, you do not 
have to wait until an event is evaluated and all the outcomes are executed to 
continue with your activities. On the other hand, due to the type of business, some 
applications such as Relationship Plan require an immediate event evaluation while 
you are using the application.

This topic covers the following:

� Types of Events

� Conditions

� Types of Condition Lines

� Types of Conditions

� Outcomes

3.9.1.1 Types of Events
Contracts offers action-based events and date-based events.

� Action-based events are predefined actions that occur in the application. 
Examples of action-based events are contract signed, contract terminated, 
counter updated, and change request initiated.
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� Date-based events are dates of significance within the application. For example, 
the contract expiration date.

You define action-based events and date-based events using the Actions window. In 
this window you also define action attributes that can be used further in conditions 
and outcomes. See Oracle Contracts Core Implementation Guide, Setting up Actions.

3.9.1.2 Conditions
You use conditions to define additional criteria for an action-based event or for a 
date-based event. The conditions also specify the outcomes that need to be initiated 
when the condition evaluates to true.

Condition lines qualify action and date-based events. They are used to specify that 
an outcome is to be initiated not only when the action happens, but also when the 
action happens and certain conditions are satisfied. For example: “when the 
contract is signed and the amount of the contract is greater than $100,000,” or “30 
days before contract expiration and when the contract category is network license 
agreement.” It is not required to define condition lines for a condition.

3.9.1.3 Types of Condition Lines
There are three types of condition lines: expressions, counters, and functions.

Using expressions, you can define simple comparisons using the operators such as 
<, >, =. Expressions are always based on action attributes.

Counter condition lines are applicable for Oracle Contracts for Service and Installed 
Base. You define conditions for a particular counter reaching a value. Counters can 
be defined for a product or for a service. For example “when the number of 
photocopies for a photocopier is greater than 1,000,” or “when the number of calls 
made by a customer in a gold service agreement is over 10."

Functions can be used for more sophisticated criteria that can be addressed using 
PL*SQL procedures. A function accepts one or more parameters and returns true or 
false after its evaluation. Functions don’t need to be based on action attributes.

3.9.1.4 Types of Conditions
There are two types of conditions:

� Independent conditions

� Conditions attached to contracts
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Using condition templates, you can define multiple samples of conditions. From a 
template you can define either an independent condition or a condition to be 
attached to a contract.

Independent conditions are not owned by any object. Whenever an action occurs, 
regardless of the contract, the outcome is initiated if the condition evaluates to true. 
For example, “whenever any contract is signed; create a task to notify the Contracts 
administrator.”

Conditions can be specific to contracts. Depending on the action, a condition can be 
related to a contract line or to a contract as a whole. For example “when the contract 
is signed” relates to the entire contract, and “when the contract line is terminated” 
relates to a line of the contract.

3.9.1.5 Outcomes
An outcome is an automated process that performs a task such as initiating a 
service request workflow or sending a notification. When the condition is true, the 
outcomes associated with that condition are performed. 

An outcome is initiated using Oracle Workflow. For versions prior to 11.5.3 the 
profile option "OKC: Success Message Recipient" is setup to notify a recipient of a 
successful outcome. Oracle Workflow has the capability of notifying a recipient of 
the success or failure of an outcome. The recipient can be the same person for 
success and failure or you can select a different person for both. For example a 
Contracts administrator maybe selected as the success recipient and a system 
administrator is selected as the failure recipient. 

Before an outcome can be associated with a condition, it must be defined using the 
Process Definition window. There are four types of outcomes: workflow, PL/SQL 
procedure, alert, and script. Workflow and PL/SQL procedure are outcomes. Alerts 
are synchronous outcomes. 

You cannot use script for outcomes. Script is not referring to a SQL script. Script is 
only valid for the type of "outcome" to support Relationship Plan functionality as a 
synchronous event. 

3.9.2 Query a Condition
You can query a condition using the Query Condition form. From this form you can 
also display the Condition Occurrence Details window. This window shows the 
details for a condition occurrence.
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Steps
1. From the Contracts Manager responsibility, choose Contract Events > Query 

Condition. The Query Condition window appears.

2. Enter your search criteria and execute.

3. If the Last Occurrence field is populated with a date, then click Last 
Occurrence. The Occurrence Details window appears. This "view only" window 
displays the following attributes:

� Occurrence Date: The date that the condition evaluated to true.

� Condition Name: Name of the condition.

� Action Name: Shows the action that was triggered for the condition to 
evaluate to true.

� Action Attributes

– Action Attribute: Shows the attributes of the action used in the 
condition.

– Attribute Value: Shows the value of the action attributes when the 
condition was evaluated true.

3.9.3 Copying a Condition Template
Use this procedure to copy a condition template into your contract.

Steps
1. Navigate to the Contracts Authoring window.

2. Click the Conditions button.

3. Select Copy From Template from the Actions menu.

4. Use the Condition Template list of values (LOV) to enter the condition template 
name.

5. Modify or amend the condition for the current contract.

3.9.4 Creating a Contract-Specific Condition
Use this procedure to create a contract-specific condition for your contract. 
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Steps
1. From the Navigator, choose Contract Events > Define Independent Condition. 

The Independent Condition window appears.

2. Enter a name and a description.

3. Select the Create a Task check box if you want to create a task. You have access 
to the tasks through the CRM Task Manager as well. Creating a task requires 
entering a task owner.

4. Select the condition type. For the Action you must select an action from the 
Action Based Conditions LOV. For the Date you must enter the number of days, 
qualify before or after, and the triggering date.

5. For condition of type action choose if the event is evaluated only once or each 
time the condition is met. For example: Select the Evaluate Once Only check box 
if you want to evaluate the condition to true only if the counter exceeds 1,000 
for the first time. Do not select the check box, if you want the condition to 
evaluate to true each time the counter reaches 1,000.

6. Enter information to create condition lines.

7. Display the condition lines and check validity.

Select the Show Condition button to display all condition lines and check their 
syntactical validity on-line. The Valid field is displayed only and gives you a 
quick overview if the condition has validated successfully.

8. Select Outcomes previously defined in the Process Definitions window.

9. Select the Parameter button to assign fixed values or action attribute values to 
the outcome parameters.

10. Save your work.

3.10 Running the Quality Assurance Check
Use this procedure at any time to check if your contract passes Quality Assurance 
(QA). The results are displayed as soon as the check completes. The levels of 
Severity are:

� Success

� Warning

� Error
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For any Process Name that receives an "Error", it means the contract has failed QA. 
The contract cannot be submitted for approval until errors have been resolved 
within the contract. This procedure is not required before submitting a contract for 
approval because a check is automatically made during the approval process. You 
can use this check to verify the completeness of your contract.

Steps
1. Navigate to the Contracts Authoring window.

2. Click Check Contract. The Quality Assurance Results window appears.

3. Review the results.

4. If contract passed QA, then click Continue Approval.

5. If Contract failed QA, then review causes.

6. Click OK to close the Quality Assurance Results window.

7. Revise contract as needed, and repeat this procedure. 

3.11 Submitting Contract for Approval
You can submit contracts for approval from the Contracts Authoring form or use 
the QA report.

3.11.1 Submitting From Authoring Form
This procedure would be used by a contract administrator for submitting the 
contract for approval. The contract manager or approver follows this procedure for 
locating the contract and approving, rejecting, or reassigning the contract.

Prerequisites
This procedure requires Oracle Workflow for contract approval and signature.

Steps
1. Navigate to the Contracts Authoring window.

2. From the Actions menu, choose Submit for Approval, or select the Submit for 
Approval from the Contracts Authoring window. The Quality Assurance check 
executes automatically. The contract can only be submitted for approval only if 
it passes Quality Assurance. 
Contract Authoring 3-37



Submitting Contract for Approval
3. Click Continue Approval. A Note window appears with a message "Process 
started successfully". Click OK. Another Note window appears with a message 
"The process APPROVAL PROCESS is active for this contract. You cannot 
change this contract." Click OK.

4. Navigate to Oracle Contracts window > Launchpad tab.

5. Click Find. The Inbox Find window appears.

6. Select "Open" for Select Status.

7. Select "Contract Approvals" for Select Notification Type.

8. Click Find.

9. Select the contract from the Inbox.

10. Click Respond. The Worklist window appears.

11. From the Subject column, click the title (Contract XXX - requires your approval). 
The Notification Details window appears.

12. Perform one of the following operations: Approve, Reject, or Reassign.

Approve

1. If you want to approve the contract, click Approve. The Worklist window 
appears.

2. Refresh your browser. The Subject column contains a message "Contract 
XXX - has been approved by........". You are now ready to have contract 
signed.

Reject

1. If you reject the contract, enter the reason in the Note region.

2. Click Reject. The Worklist window appears.

3. Refresh your browser. The Subject column contains a message "Contract 
XXX - has been rejected by ........"

Note: The Active Process field within the header automatically 
populates with "APPROVAL PROCESS".
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4. From the Subject column, click the title (Contract XXX - has been rejected 
by....). The Notification Details window appears. At this point the contract 
has to be revised and submitted for approval again.

Reassign

1. If you want to Reassign, click Reassign.The Notification Details window 
appears.

2. Select a name from the LOV for Reassign to.

3. Select one of the following:

– Delegate authority for responding to this notification

– Transfer ownership of this notification

4. Click OK.

3.11.2 Submitting Through QA Report
The Contracts QA Report is a concurrent program which enables submission of contracts for 
approval through a batch process. The parameters for this program include:

 

Parameter Description

From Contract Number The first contract number for a batch.

To Contract Number The last contract number for a batch.

From Start Date The first start date of a contract for a batch.

To Start Date The last start date of a contract for a batch.

Contract Status Enables you to select a status, i.e., "entered" from an LOV.

Level of Details Enables you to select one of three reports:

� Complete Report

� Contracts with QA Errors or Warnings

� Contracts with QA success

Submit for Approval Setting the parameter to yes, submits contracts for approval after 
the successful QA check.

Ignore QA Warning Setting to yes causes contract to be submitted for approval 
despite QA warnings. 
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Steps
1. From the Contracts Manager Responsibility, (N) Control > Requests > Run.

2. Select Contracts QA Report for Request Name.

3. Enter a contract number for From Contract Number.

4. Enter a contract number for To Contract Number (Optional).

5. Enter a From Start Date or accept default.

6. Enter a To Start Date (Optional).

7. Select a Contract Status from the LOV (Optional).

8. Select Level of Details report type.

9. Select Yes or No for Submit for Approval.

10. Select Yes or No for Ignore QA Warning. 

11. Click OK.

12. Click Submit.

13. View your request. This can be done by clicking View Output from View 
Requests. The Contract Submission report appears. 

3.11.3 Signing the Contract
The contract is signed by a person having the proper authority level to do so. In 
many cases signing the contract enables it to become active. 

Prerequisites
The contract must be approved first.

Steps
1. Navigate to Oracle Contracts window > Launchpad tab.

2. Click Find. The Inbox Find window appears.

3. Select "Open" for Select Status.

4. Select "Contracts Requiring Signature" for Select Notification Type.

5. Click Find.

6. Select the contract from the Inbox.
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7. Click Respond. The Worklist window appears.

8. From the Subject column, click the title "Contract XXX - requires your 
signature". The Notification Details window appears.

9. Click Yes. The Worklist window appears.

10. Refresh your browser. From the Subject column, the title should say "Contract 
XXX - has been signed". 

11. Close Worklist.

12. Navigate to View > Find. The Search Templates and Contracts window appears.

13. Enter the Contract Number for the recently signed contract.

14. Click Search.

15. View the Status of the contract from the Results region. The Status is either 
"Active" or "Signed".

Guidelines

Contract Start Date When the start date of the contract is the same as the date 
contract is signed, then the status becomes "Active". When the start date of the 
contract is beyond the date the contract is signed, then the status becomes "Signed". 
In this case, a concurrent program will change the status to "Active" at the contract 
start date. 
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Contract Execution

This chapter provides the information and procedures related to executing a 
contract. The following topics are covered:

� Executing a Contract

� Accessing Execution

� Updating a Contract From the Overview Tab

� Viewing the History of a Contract

� Updating the Schedule

� Recording Communications

� Viewing Related Objects

4.1 Executing a Contract
During the lifecycle of a contract there are situations that may affect and change a 
contract. There maybe assigned tasks that need to be tracked. Certainly more than 
one person may have a need to monitor a contract. These individuals monitoring a 
contract may have unique needs. For example:

� Senior Management: Senior managers would like to have an overview and 
current status of the contract. They need to know all the tasks that are due or 
overdue in the contracts that they manage.

� Middle Management: Contract mangers and project administrators primarily 
focus on when the events occur, the accomplishment of deliverables, and also 
look for notes and comments logged about the contract. They need to know all 
the deliverables that are due or overdue within their groups.
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� Contract Administration: Contract administrators need to keep track of their 
upcoming obligations and events in a contract lifecycle and also monitor 
change requests and modifications. They need to enter information about 
completing their tasks and recording occurrence of any events.

� Telesales and Teleservice Agents: Agents using the eBusiness Center have the 
ability to access and view contract information. Through the eBusiness Center 
they have a wide variety of roles and may access several contract types, 
including Sales Contracts and Contracts Core. This feature requires Oracle 
Telesales integration. For more information on accessing the eBusiness Center 
and viewing contracts see, Oracle TeleSales User Guide. 

The Contract Execution component provides visibility to all the contractual items 
that affect contract execution. 

4.2 Accessing Execution
Follow this procedure for accessing the execution component.

Prerequisites
You must have access to a previously saved contract.

Steps
1. Using the Contracts Manager responsibility, navigate from Navigator - 

Contracts Manager > Launch Contracts, click Open. The Oracle Contracts 
window appears. Select the Contract Navigator tab.

2. Open a Contract Group and select a contract.

3. Either double-click the selected contract or right click mouse to access pop-up 
menu. From the pop-up menu, select Execution. A window appears having the 
contract number as the window name.

4.2.1 Updating a Contract from the Overview Tab 
The Overview tab enables you to view the contract, update the contract, extend or 
terminate a contract line. 

Steps
1. From the Contract Navigator tab, open a Contract Group and select a contract.

2. Double click the contract. The execution window opens.
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3. Select a contract line.

4. Right click the contract line and select Open. The Contracts Authoring window 
appears.

5. Click Open for Update. Contract Status changes to QA Hold.

6. Enter your updates. 

7. Click Check Contract.

8. Review QA Results.

4.2.2 Viewing the History of a Contract
The status of a contract changes during its life cycle from the time it is created to the 
time it is expired or terminated. 

Use this procedure to view status change history or older versions of a contract.

Steps
1. From the Contract Navigator tab, open a Contract Group and select a contract.

2. Double click the contract. The Execution window opens.

3. Select the History tab. 

4. To view the status change history, in the Select field, choose the Status Change 
option. You can view the following information about status change:

� Date

� Contract version number

� Current status and status prior to change

� The person who initiated the change 

� Manual or automatic change

� Reason

� User comments (when the change is manual)

5. To review versions, in the Select field, choose the Contract Versions option. All 
major versions are displayed.

6. Select the version you want to review.

7. Click Open.
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4.2.3 Updating the Schedule
Use this procedure to view scheduled events, update completed events, and record 
contingent events.

Steps
1. From the Contract Navigator tab, open a Contract Group and select a contract.

2. Double-click a contract. The execution window opens.

3. Select the Schedule tab.

Viewing Events
4. Select a Start Date (or you can leave it blank) from the LOV.

5. Select a View from the LOV (such as All Tasks, Completed Tasks, and so on).

6. Click Refresh. 

Changing Event Status to Complete
7. Repeat steps 4-6.

8. Select Event.

9. Click Complete. The Record Task Completion window appears. 

10. Select the Actual Date from LOV.

11. Click OK.

12. Click Refresh. The Status for the selected event should indicate Closed.

Recording a Contingent Task
13. Select a Start Date from the LOV.

14. Select for View “Contingent Tasks” from LOV.

15. Click Contingent. The Record Contingent Task Event window appears.

16. Select Event Type from LOV.

17. Select Occurrence Date from LOV.

18. Select Task Owner from LOV.

19. Click OK.

20. Click Refresh. The task appears.
4-4 Oracle Contracts Core User Guide



Accessing Execution
4.2.4 Recording Communications
The Communications tab allows you to record and view communications between 
any two parties... not necessarily the contract parties. The following party roles can 
be involved:

� Party Contacts and Employees (Sell contract)

� Employees and Employees (Both)

� Supplier Contacts and Employees (Buy contract)

 Any resource can be involved in the communication. These interactions should be 
possible irrespective of the status of a contract. Such communications can range 
from phone calls and e-mails to formal letters sent. You can use the attachments 
feature to attach files or e-mails to communications. 

Prerequisites
Action Items and Outcomes must be setup in Interaction History. From the file 
menu, select Switch Responsibility > CRM Administrator > Interaction History 
Administration.

Resources involved in the communication have to be registered in Resource 
Manager. From the file menu, select Switch Responsibility > CRM Administrator > 
Resource Manager > Maintain Resources > Import Resources.

Steps
1. From the Contract Navigator tab, open a Contract Group and select a contract.

2. Double-click a contract. The execution window opens.

3. Select the Communications tab.

4. Click Create. The Communication Details for XXXX (Contract Number) opens.

5. Select a Communication Type.

6. Select a Start Date.

7. Select an Agent Name.

8. Select a Party Role.

9. Select an Action Item.

10. Select an Outcome.

11. Enter a Subject.
Contract Execution 4-5



Accessing Execution
12. Enter additional information in Details.

13. Click OK.

4.2.5 Viewing Related Objects
This tab enables you to view contact quote information within Oracle Quoting or 
order details within Oracle Order Management. This information is viewed when a 
contract has been created from a quote or a sales order has been created from a 
contract.

Steps
1. Select Related Objects tab.

2. Select contract details to review.

3. Click Details.

Note: This tab is only accessible when the integration to Oracle 
Quoting or Oracle Order Management has been set up.
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Contract Administration

This chapter contains the following topics as they relate to administering or 
managing contracts:

� Maintaining Contract Groups

� Creating a Contract Template

� Copying a Contract

� Creating a Subcontract

� Creating a New Version

� Changing Status of a Contract

� Creating a Change Request

� Running Contract Reports

� Using Discoverer Reports

� Running an XML Report

� Renewing a Contract

� Extending a Contract

� Terminating a Contract

5.1 Maintaining Contract Groups 
Once you create a contract group you need to maintain its membership. You can 
manage and oversee the groups that were created by the group definition. 

This topic consists of the following:
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� Contract Groups Overview

� Creating Contract Groups

� Assigning Contracts

5.1.1 Contract Groups Overview
Contract groups provide a convenient way to organize contracts using any criteria 
you like. They are similar to folders.

Create as many contract groups as needed to help you and other users find related 
information about contracts and contract parties. You can use any number of groups 
to classify a single contract and you can nest groups within other groups. 

The groups you create can be public or private. Use public groups to group your 
contracts in a structured way that follows your company or department 
organization structure or business procedures. Use private groups to allow users to 
group contracts by their personal preferences.

If the system administrator gives you the privilege, then you can also create public 
groups that are accessible to all users. Public groups can contain individual 
contracts as well as other public or private groups.

Groups do not permit or restrict access to contracts. 

Once you create a contract group, you need to maintain its membership. You can 
manage and oversee the groups that were created by the group definition. 

5.1.2 Creating Contract Groups 
You can create, modify, or delete contract group folders using the Contract Groups 
form. During group creation you can enter the group name, short description, and 
specify whether the group is public or private. A group can be specified as public 
only if the user has the proper authority to do so otherwise the group is designated 
as private. 

Note: A very large number of contracts in a contract group will 
adversely impact performance. You can increase performance by 
adding subfolders and distributing the contract into more 
subcontracts.
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Seeded Groups
Contracts is seeded with the following groups:

� Contracts: This group is available to you when a contract is created for the first 
time.

� Template: This group has template contracts seeded with Oracle Contracts.

Public Group Guidelines
� A public group name must be unique across all public groups. 

� A public group cannot have a private group as its member.

� Recursive relationship is not allowed. For example, if group A is a member of 
group B and group B is a member of group C, then group C (or group B) cannot 
be a member of group A. 

� If a user, who is not authorized to create a public group wants to assign a 
contract to a public group, they may be able to do so only if they have 
appropriate security access (modify) for that contract. 

Private Group Guidelines
� A private group name is always unique for user, across all private groups 

owned by that user. 

� A private group owned by one user can have that same name as that of another 
private group owned by another user. 

� A private group name can be the same as a public group name.

� A private group can have a public or a private group as its member.

� A private group cannot have a private group owned by another user as its 
member. 

� A private group cannot be a member of itself. 

� Recursive relationship is not allowed.

� Users can assign contracts to their own private groups if they have appropriate 
security access (read-only or modify) to those contracts. 

� A user can switch a private group to a public group only if currently there is no 
other public group with the same name and the user has proper authority to 
create a public group.
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� The group being switched to public cannot not have any private group as its 
member. 

� A user can switch a public group to a private group only if currently there is no 
other private group with the same name for that user and the user has proper 
authority to modify a public group.

� The group being switched to private cannot have any public group as its parent 
group.

� A private group can only be deleted by the owner of that group.

� A public group can be deleted only by those users who have been grated public 
group creator privilege.

� If the group to be deleted has any member (group or contract) in it or belongs to 
any parent group, the users will be asked to confirm before deletion. If 
confirmed, the group will be deleted along with the association with its 
member. 

The following table shows the fields and descriptions for the Contract Groups form:

Prerequisites
If you want to create public groups, you must set the Profile Option OKC: Public 
Group Creator. This can be set at the responsibility and user levels.

5.1.2.1 Create Contract Groups

Steps

1. From the Contracts Manager responsibility, (N) Contract Groups > Define 
Contract Groups.

2. Enter a name for Contract Group.

3. Enter a description.

Field Description

Name The name of the contract group.

Short Description Contains a short description of the group.

Public If selected this group is defined as a public group otherwise it 
remains private. The default value for this check box is 
deselected. If you do not have authority to define a public 
group, this check box will remain disabled. 
5-4 Oracle Contracts Core User Guide



Maintaining Contract Groups
4. If this group is Public, then select Public check box. 

5. Close the form and save your work. 

5.1.2.2 Delete Contract Groups

Steps

1. From the Contracts Manager responsibility, (N) Contract Groups > Define 
Contract Groups.

2. Select the contract group you want to delete.

3. (M) Edit > Delete. You may receive a note warning you that the group may 
either have contracts or is a subgroup to another group.

4. Click OK.

5.1.3 Assigning Contracts 
Use the Contract Groupings form to maintain group hierarchies or to assign 
contracts to groups. Grouping of contracts is for organizational purposes only.

You can use the Contract Grouping form to change the group that a contract is 
associated with, without opening the contract for update. Contracts with any status 
(including Active status) can be added or moved from one folder to another. 

You can assign a contract to one or more groups. This can be done while authoring a 
contract or later by accessing the relevant contract group.

The following table shows the fields and descriptions for the Contracts tab of the 
Contracts Groupings form:

Field Description

Currently Assigned 
Contracts

This is the list of contracts that are currently assigned to the 
selected group.

Available Contracts This panel displays all the contracts that are currently available 
for assignment. Only those contracts for which you have the 
Read or Modify access are displayed.

Find To open the Search Templates and Contracts form, click the Find 
button.
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The following table shows the fields and descriptions for the Groups tab of the 
Contracts Groupings form:

5.1.3.1 Assign a Contract Group to a Group

Steps

1. From the Corporate Contracts Manager, choose Contract Groups > Assign 
Contract Groups (T) Groups.

2. Select a contract group from the Contract Navigation tree. The available groups 
for assignment are displayed. 

3. Select an available subgroup.

4. Click the left arrow to assign the subgroup. The subgroup appears in the left 
pane. 

5. Close the form and save changes. 

5.1.3.2 Assign a Contract to a Group

Steps

1. From the Corporate Contracts Manager, choose Contract Groups > Assign 
Contract Groups (T) Contracts.

2. Click (B) Find. The Search Templates window appears. 

3. Enter your search criteria.

4. Click Search.

5. Navigate to the Contract Groupings window. The contract number should 
appear in the Available Contracts region.

Field Description

Currently Assigned 
Subgroups

This is the list of groups that are currently assigned to a selected 
group.

Available Subgroups This panel displays all groups that are currently available for 
assignment.

View This LOV has two options: Unassigned and Show All. It allows 
you to view either unassigned groups (not belonging to any 
group) or all groups belonging to other groups and unassigned 
ones in the Available Contracts panel.
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6. Select the contract number and click the left arrow.

7. Save your changes and close the Contract Groupings window. The contract 
should be assigned to a new contract group.

5.1.3.3 Assign a Contract to a Group Using the Authoring Form

Steps

1. From the Corporate Contracts Manager, choose Launch Contracts (B) Open.

2. If this is a new contract, (N) (T) Contract Navigator (M) Tools > New.

3. If this is an existing contract, select the Contract from the Contract Navigator 
tab and right click. From the pop up menu, select Open. 

4. (N) (T) Summary (T) Details.

5. Select the Name from the Groups region

6. Save changes. 

5.2 Creating a Contract Template
Use this procedure to create a contract template.

Steps
1. Navigate to the Contracts Authoring window.

2. Enter a contract number to identify the template.

3. Select the Buy or Sell option for intent. 

4. Enter an end date.

5. In the Details subtab, enter at least one group name.

6. Navigate to Actions > Save as Template.

7. Enter the Template Name and optionally the Adjustment.

8. Click OK.

Guidelines
In some situations you may open an existing contract and save it as a template. 
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When you open a template within the Contract Authoring window you see 
Template Name as a field instead of Contract Number. 

5.3 Copying a Contract
There are several ways to copy a contract, parts of a contract, or multiple contracts.

Steps
1. Navigate to the Copy window using one of the following ways:

� In the Contract Navigator, select a contract group, right-click the contract, 
and choose Copy.

� Open an existing contract. In the Authoring window, choose the Copy from 
Contract/Template option from the Action menu.

2. In the Copy window, enter the new contract name, and optionally, a contract 
adjustment.

3. From the left side, select the contract or part of the contract you want to copy.

4. Click the double right-arrow button to move the existing contract or parts on 
the left side to the right side. Anything on the right side is considered part of 
the new contract. 

5. Optionally, click the double left arrow button to move a new contract or parts of 
a contract back to the existing contract area on the left side. 

6. Click Create.

Your new contract with copied contract information is now saved. You can then 
make changes to the newly created contract in the same way that you would 
when authoring a contract.
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5.4 Creating a Subcontract
In order to fulfill the obligations of an existing contract, a party may need to 
establish a new contract with a third party to provide some or all of the items, such 
as materials or deliverables, required in the original contract. This is called creating 
a subcontract. These subcontracts need to maintain relationships between the 
components, such as terms and lines, of the parent agreement and those of the new 
contract. You can create a subcontract and further specify those articles or rules 
from the prime contract or master agreement that are to flow down to, and be 
incorporated into a subcontract.

Also, you can create task orders from a master agreement, with the terms and 
conditions of each task order linked from the master agreement. Alternatively, you 
can simply reference other contracts (and by inference, the terms and conditions of 
those other contracts) without specifying any particular details. 

Using subcontracts, you can:

� Subcontract the components into an existing contract or a new contract.

� Maintain data consistency for the subcontracted contract. For example, a 
subcontract would not contain your customer as a customer in the subcontract.

� Select multiple lines or sublines for subcontracting.

� Inherit terms and conditions from higher levels in the hierarchy for the 
subcontracted lines or sublines.

� Reference terms and conditions.

� Modify the copied components.

You can select the lines or sublines and also the components such as parties, articles, 
and rules at the contract header level for subcontracting. After selecting the 
components, click the right arrow button to move them to the right navigator 
window.

When you create a subcontract, all selected components are copied into the 
subcontract. You can modify the components. You can also select parties to copy to 
the subcontract, but normally this is not useful because the roles change for a 
subcontract.

Prerequisites
An active contract must be in place.
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Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select a contract group.

3. Right-click a contract and choose Subcontract. 

4. On the right side, enter the name and optionally a modifier for the new 
contract.

5. Select a category for the new subcontract.

6. Select the Intent.

7. Select the Perspective.

8. If you want to reference to the subcontracting contract instead of copying 
components, then select Keep References. You cannot change referenced 
components in the new subcontracted contract.

9. Highlight the desired components in left navigator, click the forward arrow 
button and click the Create option in the Subcontract Components Selection 
pop-up menu.

You can make changes to the new subcontract in the Contract Authoring window.

5.5 Creating a New Version
Use this procedure to create a new version of a contract. Subsequent versions can be 
viewed from the History tab within the Contract Execution window. 

Steps
1. From the Navigator, choose Launch Contracts. The Oracle Contracts window 

appears.

2. In the left window of the Contract Navigator tab, select a contract group.

3. Right-click a contract and choose Create New Version. This creates a new 
version of your contract.

Guidelines
When you create a new version, the digit in front of the period (the main version) is 
increased by one. The minor version is reset to zero.
5-10 Oracle Contracts Core User Guide



Changing the Status of a Contract
5.5.1 Contract Versioning Without Revert Option
Creating historical version for contracts with huge amounts of data can be a time 
consuming process. To improve the performance, the following profile options are 
now available:

� Default Contract Revert Option: Use this option to indicate whether to 
automatically create a backup version when active contracts are opened for 
update or change requests are applied. If the profile is set to Allow Revert, 
when you open a contract for update and save the changes, the system will 
allow you to disregard the changes by selecting the Revert option from the 
Action menu. If the profile is set to "Do Not Allow Revert", the system will not 
create a backup version of the contract, and therefore, you cannot reverse the 
changes made to the contract.

� Warn/Confirm Default Contract Revert Option: If this option is enabled, when 
an active contract is opened for update or a change request is applied, the 
system displays the Warning/Confirmation window. You can use this window 
to confirm or skip the contract version creation. In the Warning/Confirmation 
window, you also have the option to override the Default Contract Revert 
profile value.

5.6 Changing the Status of a Contract
Use this procedure to change the status or status type of a contract. The contract 
status determines the operations allowed in the contract and status type.

In the following table, auto means that the Status Change concurrent program 
automatically changes the status when the conditions for a status change are met.

Status to 
From

Entered Signed Active Hold Expired Terminated Canceled

Entered Yes Yes/

through 
approval

Yes/ 
throug
h 
approv
al

No No No Yes

Signed No Yes Yes/au
to

Yes Yes/

auto

Yes No

Active No No Yes Yes Yes/

auto

Yes No

Hold No Yes Yes Yes Yes No No
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5.6.1 Changing Status Manually
This procedure is used when the status transitions allow a manual change.

Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select a contract group.

3. Right-click a contract and choose Change Status. The Contract Status window 
appears.

4. Select the New Status from the list of values.

5. Select a Reason from the list of values. If you need to add more reasons for the 
status change, your system administrator can add more options in the Lookup 
Codes.

6. Use the Comments field to enter any additional information (optional).

7. Close the Contract Status window and save your changes. 

8. In the Contract Navigator tab, right click and select Refresh from the pop up 
menu. The contract shows the new status that you assigned. 

5.6.2 Changing the Status of a Contact Automatically
There are two concurrent programs used to automatically change the status of a 
contract:

� Contract Status Change by Range

� Contract Status Change by Contract

These programs are used when the status transitions are not manual. Certain status 
transitions are made based upon the start date or end date on a contract or on a 
contract line. For example, a contract gets expired when an end date is reached. A 
contract becomes active from the signed status when the start date is reached. This 
is achieved through the concurrent program.

Expired No No Yes No Yes No No

Terminated No No No No No Yes No

Canceled Yes No No No No No Yes

Status to 
From

Entered Signed Active Hold Expired Terminated Canceled
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5.6.2.1 Contract Status Change by Range
This concurrent program may have already been scheduled to run as part of the 
setup for Contracts Core. 

Steps

1. From the Contracts Manager responsibility, (N) Control > Requests > Run.

2. Select the Contracts Status Change by Range option for the name.

3. Enter the following optional parameters:

� Category

� From Number

� To Number

� From Modifier 

� To Modifier 

4. Click OK.

5. Click Submit. 

5.6.2.2 Contract Status Change by Contract
This program works for a specific contract. 

Steps

1. From the Contracts Manager responsibility, (N) Control > Requests > Run.

2. Select the Contracts Status Change by Contract option for the name.

3. Enter the following parameters:

� Contract Number (Required)

� Contract Number Modifier (Optional)

4. Click OK.

5. Click Submit.

5.6.3 Status Change History
The status of a contract changes during its life cycle from the time it is created to the 
time it is expired or terminated.In Oracle Contracts any new contract is created with 
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the Entered status. You can use the Status Change History feature to review the 
history of status change for a contract. The History tab of Execution window 
displays the following information about status change:

� Date

� Contract version number

� Current status and the status prior to change

� The person who initiated the change 

� Manual or automatic change

� Reason

� User comments
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5.7 Creating a Change Request
Change Request is a formal way to document changes to a contract. A request is 
approved by the approver defined in the workflow selected and submitted for the 
change request. Once your change request is approved, the administrator assigned 
in the change request receives a notification that the contract can be changed.

An internal key gives the change request administrator Update access to the 
contract. When the administrator changes, it is locked for other change requests 
until the change request is closed.

Prerequisites
The status and operations must allow changes for that category and status.

Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select the contract you want to change.

3. Right-click the contract and choose the Create Change Request option. The 
Create a Change Requests window opens. 

4. Enter the request name and a description.

5. Enter the requester’s name. This person will receive a workflow notification 
when changes are approved and can be applied to the contract.

6. Enter the request date and effective dates.

7. If you want to version the changed contract, then select Version.

8. If you want to have a signature required, then select Signature Required.

9. Record the lines where you are requesting a change and the exact nature of the 
change.

10.  Select the Admin tab.

11. Select the Approval workflow.

12. Select an Administrator.

13. Select Party Approvals (optional).

14. Save record. If not done, you receive the "Please create/save the change request 
before submitting for approval." error message.
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15. Click Submit for Approval. You should receive the Note message "Submitted 
for approval." Click OK.

5.7.1 Approving, Applying, and Closing Change Requests
The change request must first be approved before the contract can be changed. 
After the change request has been approved, you can open the contract and apply 
the changes as described in the change request notification. Once you start editing 
the contract, you automatically lock the contract for other users with an approved 
change request.

Prerequisites
In order to apply changes, the change request notification must be open in your 
inbox and no other change request can be in process.

Steps

Approving a Change Request
1. From the Navigator, choose Launch Contracts.

2. From the Launchpad, find the Change Request Approval (assuming the 
approval workflow routed the change request approval to you, otherwise 
switch users).

3. Select the contract from the Inbox and click Respond. 

4. Click Approve.

5. Requery the Inbox to ensure the Change Requests is Approved for the specific 
contract. 

Applying Changes
6. In the Launchpad tab, select the approved change request notice in your inbox 

and click Open. The Contract Authoring window appears (the status of the 
contract should be QA Hold).

7. Edit the contract according to the approved changes.

8. Save and close the contract.

Closing a Change Request
9. In the Contract Navigator tab of the Oracle Contracts window, select the 

contract that you changed (make sure you have refreshed the window).
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10. Double-click the contract. The Contract window appears.

11. (N) (T) Overview. Select the contract, right click and select the Open option 
from the pop up menu.

12. Click Check Contract. If QA is successful you should receive the "QA 
completed successfully!" note. 

13. Click OK. If the contract passes the QA, the status returns to "Active".

5.7.2 Updating Contracts Online
You can also update a contract (after the contract has gone through the approval 
process) through the Update Online operation. Once the changes are entered and 
saved, a QA check is run for the contract. If you are unable to resolve QA issues, 
there is a "Revert" option that allows you to recover the original contract before the 
changes. If the contract passes the QA then the status returns to "Active".

Prerequisites
� Set the OKC: Global Update Privileges profile option to "Yes".

� Applies only to Contracts with Active, Signed, and QA Hold status.

� Grant the Update Online function to the user responsibility

� User must have, at least, Read Only access to the contracts.

� Other users should not have the Change Request lock on the contract.

Steps
1. Open the Contracts Authoring window for a contract.

2. Click the Open for Update button. The Contract Status should change from 
"Active" to "QA Hold". This locks the contract.

3. Make the necessary changes to the contract.

4. Save changes.

5. Click Check Contract.

6. Review the quality assurance results.

7. If QA is passed, the Contract Status changes from "QA Hold" to "Active". 

8. If QA fails, the status will remain "QA Hold". You can recover the original 
contract by selecting the Revert option from the Actions menu.
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5.8 Running Contracts Reports
Oracle Contracts provides the following reports:

� Contracts Details Report: This report provides key data such as Contract 
Number, Parties, Articles, Rules and so on for a contract. 

� Contracts QA Report: You can select to have this report show: QA errors, QA 
success, or both QA errors and QA success. 

� List of Contracts by Contract Group: These reports are run using their 
concurrent programs.You cannot change the format of these reports.

5.8.1 Contract Details Report

Prerequisites
Contracts Details Report requires a printer set up for printing the report.

Steps
1. From the Contracts Navigator, select Control > Requests > Run (B) Open. The 

Submit Request window appears. 

2. Select Single Request.

3. Click OK.

4. In the Name field, select the Contract Details report. The Parameters window 
appears.

5. Select or enter the following based on your requirements:

� Contract Number: The contract number for which you want the detailed 
report. 

� Party Role: The name of the parties to a contract (i.e. Customer or Vendor 
Name).

� Print Articles: Select Yes or No, depending on if you want the articles to be 
printed. 

� Print Article Text: Yes or No

� Print Sections: Yes or No

� Print Rules at Header Level: Yes or No

� Print Rules at Line Level: Yes or No
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6. Click Submit.

7. Click Schedule.

8. Select when to run the Job.

9. Click OK.

10. Click Submit.

11. Review the results.

5.8.2 Contracts QA Report
The Contracts QA Report can be generated after you submit a contract for QA 
check. 

Steps
1. From the Contracts Navigator, select Control > Requests > Run (B) Open. The 

Submit Request window opens. 

2. Select the Single Request option.

3. Click OK.

4. In the Name field, select the Contract QA report. The Parameters window 
appears.

5. Select or enter the following based on your requirements:

� From Contract Number: Enter the contract number range from where to 
start. 

� To Contract Number: Enter the contract number range from where to end.

� From Start Date: Start Date from which you want the QA reports of the 
contract

� To End Date: End Date to which you want the QA reports of the contract

� Contract Status: Status of a contract. You can select Active, Cancelled, 
Entered, Expired, QA Hold, Terminated etc.

� Level of Details: Complete Report, Contract with QA Errors, Contract with 
QA Success.

6. Click OK.

7. Click Schedule.
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8. Select when to run the Job.

9. Click OK.

10. Click Submit

11. Switch Responsibilities to System Administrator to view the results.

12. From System Administrator Navigator > Requests > View. The Find Requests 
window appears.

13. Click Find. The Requests window appears.

14. Review the results.

5.8.3 List of Contracts by Contract Group

Steps
1. From the Contracts Navigator, select Control > Requests > Run (B) Open. The 

Submit Request window appears. 

2. Select the Single Request option.

3. Click OK.

4. In the Name field, select the List of Contracts by Contract Group report. The 
Parameters window appears.

5. Select or enter the following based on your requirements:

� Group: The Contract Group containing the contracts

� Role: The Customer Role such as Buyer, Contractor, and so on

� Category: The contract categories

� Start Date From: The contract start date

� Start Date To: The contract end date

� Contract Status: Status of a contract. For example, Active, Cancelled, 
Entered, Expired, QA Hold, Terminated etc.

� Currency: The currency type.

� Order by Amount: Yes or No

6. Click OK.

7. Click Schedule.
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8. Select when to run the Job.

9. Click OK.

10. Click Submit

11. Switch Responsibilities to System Administrator to view the results.

12. From System Administrator Navigator > Requests > View. The Find Requests 
window appears.

13. Click Find. The Requests window appears.

14. Review the results.

5.9 Using Discoverer Reports
Discoverer Reports is a reporting feature which allows you to search for desired 
contract data and export this data to a customizable report such as HTML, MS Excel 
spreadsheet, or other type of output. There are two seeded reports with Contracts 
Core: Contracts Expired but not Renewed and Contract Listing. For procedures on 
how to run these reports see Running Discoverer Reports.

5.9.1 Contracts Expired but not Renewed Report
This report searches for missed opportunities such as contracts that have expired. It 
will show a list of expired contracts but not renewed only if:

� Party role is a customer on the contract.

� Contract role is a Support Sales

� Contact person is in a sales territory.

This report displays the following fields:

Fields Included in Report     

Contract Number Status Amount

Currency Start Date End Date

Customer Sales Person Territory

Report ID Last Updated Date     
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Prerequisites
To determine which expired contracts to be included in this report, the following 
profile must be set up:

� OKC: Expired Past days

5.9.2 Contract Listing
This report allows you to use the same search criteria as the Search Templates and 
Contracts Query window to identify contracts and view the list in Discoverer. 

With these reports, contract administrators and managers can analyze which 
contracts expired but were not renewed and they can view a list of contracts defined 
by a custom query using their own search criteria. 

5.9.3 Running Discoverer Reports
Follow this procedure for running Discoverer Reports. 

Reference
Oracle Contracts Core Implementation Guide

Prerequisites
The User Name selected for login must have assigned privileges.

Steps
1. Login to the Contracts Manager responsibility.

2. Select Launch Contracts. 

Fields Included in Report     

Contract Number Modifier Version

Category Description Start Date

End Date Status Approved Date

Signed Date Terminated Date Renewed Date

Canceled Date Last Update Date Currency

Amount Known As   
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3. From the menu bar, navigate to Tools > Reports. The Contract Reports pop-up 
window appears.

4. Select the Contracts Listing option from LOV.

5. Click OK. The Contracts Reports window appears.

6. Enter your search criteria.

7. Click Print. The Contracts Listing page appears. 

8. Select the Export Data link. The window refreshes showing an LOV for "What 
export format do you want?".

9. Select Export Format from LOV, such as Microsoft Excel Workbook.

10. Click Export Data. An Excel spreadsheet appears displaying Contract Listing 
data. 

11. Optionally, save to local drive.

12. Close Discoverer browser windows.

13. Repeat above steps for running the "Expired Contracts but not renewed" report.

5.10 Running an XML Report
Follow this procedure when initiating contract preview from the Contracts 
Authoring form. You can use this procedure for a contract of any status that has 
Line Items and Articles defined. Selecting from the main menu Tools > HTML 
Preview or Tools > MS Word Preview a validation will automatically run which 
checks that all articles of the contract have been added to the Sections tab. You can 
choose the report type and file format that need to be generated and displayed in 
your browser. The report can then be printed or saved from the browser.

Reference
Oracle Contracts Core Implementation Guide, Setting Up XML Reports

Prerequisites
A contract must be created for preview. 

Steps
1. Navigate to the Contracts Authoring form and select the Articles tab.
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2. Review and update articles including any Keywords (tags) in the articles. For 
example, <CUSTOMER_NAME/> may terminate any program license at any 
time; however, termination shall not relieve obligations due to <CUSTOMER_
NAME/> specified in Section 4.4. The keywords that have already been defined 
in the XML file can be inserted directly into article text, either in the article 
library or in the article for a specific contract. 

3. Click the Sections tab.

4. Select the sections and sequence from the tree located to the left of the window. 

5. Select the articles and sequence you wish to print. If articles are not included in 
the Sections tab they will not be printed. When the number of articles on the 
Sections tab is different then the number of articles listed in the Articles tab a 
warning message appears. The message alerts you that articles not included in 
the Sections tab will not be printed.

6. Save your work.

7. Navigate to Tools menu and select one of the following:

� HTML Preview - The contract format is based on the XML stylesheet 
chosen and previewed in HTML.

� MS Word Preview - The contract format is based on the XML stylesheet 
chosen and previewed in MS Word.

8. Select a report from the Report Types window. If an article is not included in the 
Sections tab, it will not be printed. A warning message appears alerting you 
that the number of articles listed in the Articles tab is different than the number 
of articles in the Sections tab. 

9. Review the file generated. 

10. To print the report select: (N) File > Print

11. If you have Adobe Acrobat installed, you can save the report as a pdf file. For 
example: 

� (N) Save As 

� Enter the file name. For example, Myreport.pdf.
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5.11 Renewing a Contract
Renewing a contract does not affect the current contract. It creates a new contract by 
copying the current contract. You can renew a contract only once. 

For example: You can renew contract A100-2001 and create the renewed contract 
A100-2002. Then you cannot renew the contract A100-2001 again, but you can 
renew contract A100-2002 into contract A100-2003.

Prerequisites
The contract must be in active, signed, or expired status.

Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select a contract group.

3. Select one or more contracts, right-click, and choose Renew.

4. To keep the new contract distinguishable, the modifier is defaulted to the value 
you set in the profile option OKC: Renewed Contract Identifier, with the current 
date appended. You can change the modifier to another value.

5. If the renewal is for a non-perpetual contract, the new start date is defaulted to 
the date following the end date of the current contract. Either select an end date 
for the renewed contract or enter values for duration and period. For example, 
to renew a contract for six months, enter 6 in the Duration field and select 
Month in the Period field.

6. If the renewal is for a perpetual contract, select the Perpetual check box.

7. To launch the Renewal process as a concurrent request, select the Submit 
Request checkbox. If you select the checkbox and click the Renew button, a 
concurrent request is launched and the request ID is displayed. If the Submit 
Request checkbox is unchecked, the Renewal will be online.

8. Click Renew. A copy of the current contract is saved.

5.12 Extending a Contract
Use this procedure to extend a contract. Extending a contract changes only the date 
a contract is scheduled to expire and possibly changes the status of the contract and 
lines from expired to active. You can also extend a contract line, see Extending a 
Contract Line
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Prerequisites
The contract must have a status of Active or Expired.

Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select a contract group.

3. Select one or more contracts, right-click, and choose Extend. The Extend 
window appears.

4. If the extended contract is non-perpetual, either select a new end date for the 
contract or enter values for duration and period. For example, to extent a 
contract for a further six months, enter 6 in the duration field and select Month 
in the Period field.

5. If the extended contract is to be perpetual, select the Perpetual check box. The 
lines will also be perpetual. 

6. Click Extend.

5.12.1 Extending a Contract Line
Use this procedure to extend a line on an active contract. Extending a line may 
change the end date of a contract. When the extended line is scheduled to expire on 
the new end date and if applicable, adjusts the end date of the contract.

Prerequisites
The contract line must have a status of Active or Expired.

Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select a contract group.

3. Double-click a contract to see the overview.

4. Select the line or lines you want to extend.

5. Right-click and choose Extend. The Extend window opens.

6. Either select a new end date for the line or enter values for the duration and 
period. For example, to extent a contract line for further six months, enter 6 in 
the Duration field and select Month in the Period field.
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7. Click Extend.

Guidelines
If you extend a contract line beyond the end date of a contract, the end date of the 
contract is automatically updated to the end date of the extended line.

5.13 Terminating a Contract
Use this procedure to terminate a contract that is active or effective and on hold. 
You can also terminate a contract line, see Terminating Contract Lines.

Prerequisites
The contract must have a status of Signed, Active, or Hold.

Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select a contract group.

3. Select one or more contracts, right-click, and choose Terminate. The Terminate 
window appears.

4. Enter a termination date and a termination reason.

5. Click Terminate.

Guidelines
If you want to add more reasons for a termination, your system administrator can 
add more options in the Lookup Codes.

Note: For most terminations the Contracts Core Termination form 
is used. However when using Contracts for Service with the 
contract class “Service”, a Contracts for Service “Terminate 
Contracts” form is used. This form displays the amount to be 
credited with an option to override this. After performing the 
processing for credits, Contracts for Service will call the Contracts 
Core terminate API.
Contract Administration 5-27



Terminating a Contract
5.13.1 Terminating Contract Lines
Use this procedure to terminate a contract line in an active contract. If you want to 
add more reasons for a termination, your system administrator can add more 
options in the Lookup Codes.

Prerequisites
The contract status is Active and the contract lines have a status of Active or Hold.

Steps
1. From the Navigator, choose Launch Contracts.

2. In the Contract Navigator tab, select a contract group.

3. Double-click a contract to see the Overview.

4. Select the line or lines you want to terminate.

5. Right-click and choose Terminate. The Terminate window appears.

6. Enter a termination date and a termination reason.

7. Click Terminate.

Note: For most contract line terminations the Contracts Core 
Termination Line form is used. However when using Contracts for 
Service with the contract class “Service”, a Contracts for Service 
“Terminate Contract Lines” form is used. This form displays the 
amount to be credited with an option to override this.
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Using Contracts Online

This chapter presents the following topics and processes as they apply to Contracts 
Online:

� Overview 

� Key Features

� Accessing Contracts Online

� Searching Contracts

� Importing Contracts

� Authoring a Contract

� Updating Library of Articles

6.1 Overview
Contracts Online is a web based feature of Oracle Contracts Core. It enables 
companies to automate and manage their contracts more effectively. Contracts 
online provides access to an enterprise’s global repository for the collection and 
dissemination of contract information. It provides users a solution to quickly 
upload images and files of existing hard copy contracts and referenced documents 
into an automated system This allows them to have a better control of their business 
while providing secured visibility to contracts information.

Contracts Online provides a quick and easy transition step toward automating and 
integrating contract information into an enterprise's e-business solution. The key 
benefits of Contracts Online include:

� Global visibility:

� Internal and external party access
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� Secured access based on role and function with visibility across 
organizations

� Images and document attachments with download capability

� Quick and easy way for customers to upload authored contracts (e.g. file 
cabinet, word, etc.).

� Light authoring process that helps the transition to sales and procurement 
contracts.

6.2 Key Features
The key features of Contracts Online are:

Search Contracts
The Search Contracts function enables you to quickly find contracts or templates by 
using a single search criteria such as Contract Number, Attachment Name, Known 
As, and Primary Party name. The Search Results window displays a table listing 
some contract attributes such as Contract Number, Primary Party, Party Role, 
Status, Category, Amount, and Attachments. 

Create and Update Contracts
You can create contracts with minimum required information. You can also create a 
contract and save it as a template for future contracts. You can update contracts and 
templates. After a contact is created, you can search for the contract and update 
information such as, status, dates, and description. 

Save as Contract
The "Save as Contract" feature allows you to create a new contract by simply 
copying from either a contract or from a template. 

Create Template
You can create a template by either copying from a contract, copying from a 
template, or creating a template from scratch. 

Attach Documents to Contracts
Contracts Online provides users the ability to attach any type of file or web page 
related to a contract. You can view the list of attachments related to a contract.
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Library of Articles
Contracts Online provides you the ability to define the contract terms and 
conditions (which are the articles of a contract). You can create a central repository 
of articles by using the Library of Articles functionality. In the Library of Articles 
you can define new standard articles, create new article releases, and view and edit 
existing articles. 

Import Contract
You can upload contracts that are stored in a local file and migrate them to 
Contracts Online. The import feature enables you to easily create multiple contracts 
based on a template or a contract. 

External Party Interface
External parties to a contract can access Contracts Online to view their contracts. To 
be able to access the External Party Interface, the party is required to register with 
Oracle eBusiness Suite (Please refer to Oracle CRM Foundation Concepts & Procedures 
for registration details).

After the party is registered and given access to Contracts, he/she will be able to 
preview only contracts in which his/her company is one of the parties to the 
contract.

Preview Contract
The Preview feature enables you to review an entire contract before printing. The 
contract is displayed in the layout that would be printed.

Secure Access to Contracts
This feature provides the ability to grant access to individual contracts. You are able 
to define the users or group of users that can access a specific contract and their 
access level such as read only or modify.

6.3 Accessing Contracts Online
The following list represents users that would typically access Contracts Online:

� Internal: Contract administrators, legal, and sales representatives.

� External: Customers and suppliers
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6.3.1 Internal Party
You can access Contracts Online through the JTF login from the Oracle Business 
Portal. 

Steps
1. Navigate to the Oracle Business Portal.

2. Enter your User Id.

3. Enter your Password. After authentication the Contracts Online Home page 
appears.

Guidelines
In the CRM portal there is a link to access Contracts Online Home Page. You may be 
assigned a default responsibility after login from JTF. If Contracts Online is your 
default responsibility, then the Contracts Online Home Page appears.

Users can grant access to individual contracts. Users can define who can access a 
specific contract and the level of access: Modify or Read. 

See Also
Granting Access to a Contract

6.3.2 External Party
External users can search for contracts on which they are one of the parties on the 
the contract.

Steps
1. Navigate to the Oracle Business Portal.

2. Enter your User Id.

Note: For internal users, the "OKC: Contracts Online" responsibility 
is seeded. For external users, see the JTF User registration. Also 
make sure that the seeded "Contracts Online Party Access 
Enrollment" (OKC_KOL_PARTY_ACCESS key) is active and 
available for the chosen user type. 
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3. Enter your Password. After authentication, the Contracts Search window 
appears.

4. Search for a contract by querying one of the following:

� Contract Number

� Known As

� Document Name

6.4 Home Tab Overview
After logging on to Contracts Online the Home page tab appears. The purpose of 
the Contracts Online Home page is to provide useful information about contracts. 
This page is the starting point for Contracts Online product. The following bins are 
provided:

� Bookmarked Contracts - Displays the bookmarked contracts.

� Recent Contracts - Displays the most recent contracts being negotiated.

� Expiring Contracts - Displays the contracts that already expired or are to be 
expired.

You can access the contracts from any of these bins by clicking a number from the 
Contract column.

From the left side of the page, the following functionality and shortcuts are 
available:

� Create Contract - Opens the Create Contract page to enable you to create a 
contract. 

� Advanced Import - Enables you to create multiple contracts based on what you 
specify in comma separated file (i.e. contract number, category, intent, 
attachments, etc.). 

6.5 Contracts Tab Overview
The Contracts tab provides you with the ability to search and view contracts 
information as well as create new contracts, update existing ones, bookmark 
contracts, delete contracts, create templates, copy contracts, copy templates and 
import contracts.

When you click on the Contracts tab, the following links are available: 
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� Searching Contracts:

� Add to Bookmark

� Delete

� Import

� Save as Contract

� Save as Template

� Create Contract

� Authoring Contracts: A side navigation menu appears showing the following 
links:

� General Information

� Parties

� Attachments

� Articles

� Security

� Summary

6.5.1  Searching Contracts
The Search Contracts function enables you to quickly find contracts or templates by 
using one the following search criteria:

� Attachment Name: Name of the document that was attached to a contract. 

� Contract Number: Number assigned to a contract.

� Known As: Name the user has entered for a given contract.

� Primary Party: Name related to a contract.

These search criteria can be used to search templates as well. You can click the 
Search by templates only check box to restrict your search to only look for 
templates.

Prerequisites:
The user has to have at least read access to the contracts that are displayed in the 
Search Results page.
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Steps
You can search contracts from two different screens: Home Page and Contracts tabs.

1. Navigate to the Contracts tab (you can also search contracts from the Home 
page).

2. Select the search criteria from the drop-down menu (such as Primary Party 
Name).

3.  Enter a value related to search criterion (such as %Vision%).

4. Click Go. The Search Results page appears.

5. Select a contract from the Select column.

6. Select one of the following from the Action drop-down menu:

� Add to Bookmark

� Delete 

� Import

� Save as Contract

� Save as Template

� Import

7. Click Go.

8. Click the Contract Number to view the contract.

Guidelines
A user must have at least read only access to view a contract.

A user with Read only access will not be able to perform the following Actions: 
Delete, Save as Contract, Save as Template, and Import Contracts.

Use the Add to Bookmark to maintain your personal list of contracts available in the 
Home Page.

Only contracts created using Contracts Online and if the status is Entered or 
Cancelled can be deleted.

Use the Save as Contract to create a new contract by simply copying from either an 
existing contract or from a template.

Use the Save as Template to create a template by simply copying from either an 
existing contract or from a template.
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6.5.2 Importing Contracts
There are two methods for import: Basic and Advanced. 

Prerequisites
A zip file must be created containing the documents that you want to import.

6.5.2.1 Basic Import
The Basic Import function is a simple way to create multiple contracts based on a 
template or a contract. You can choose a template or contract and enter the location 
and name of a zip file which contains all documents to create a contract. For each 
file available in the zip file a new contract will be created and the file will be 
attached to the contract created.

Steps

1. From the Search Results page, select a contract or template from the Select 
column.

2. Select Import from the Action drop-down menu. 

3. Click Go. The Import page appears.

4. Click Browse to locate and select the zip file.

5. Click Submit.

6.5.2.2 Advanced Import
The Advanced Import function enables you to create multiple contracts based on 
what you specify in comma-separated value (CSV) file (i.e. contract number, 
category, intent, attachments, etc.). The Advanced Import feature is only available 
from the Home Page tab. 

Steps

1. From the Home Page tab, choose the Advanced Import shortcut. The Advanced 
Import page appears.

2. Click the Browse button to locate the Contract File Name.

3. If attachments are specified within the Contract File Name, click the Browse 
button to enter the Attachment File Name.

4. If you want to specify how many contracts you want to save during the import 
process, select the Save check box.
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5. Enter the number of contracts to be saved.

6. Click Submit to start the import. If you want to delete all information, click 
Cancel.

Guidelines

Contract File Name 

Contract File Name is a Comma-separated value (CSV) file. The CSV file must have 
a first line that is exactly the same (i.e., word for word, case, and space sensitive), as 
that specified in the Advanced Import screen. To see this header, click on the "see 
sample" link in the first page of import. The header is:

CONTRACTNUMBER,CATEGORY,INTENT,PERSPECTIVE,TEMPLATE,CURR
ENCY,AMOUNT,START DATE,END DATE,DATE SIGNED,DATE 
TERMINATED,TERMINATED REASON,SHORT 
DESCRIPTION,DESCRIPTION,PARTY1 ROLE,PARTY1 NAME,PRIMARY 
PARTY,PARTY1 CONTACT1 ROLE,PARTY1 CONTACT1 NAME,PARTY1 
PRIMARY CONTACT1,PARTY1 CONTACT2 ROLE,PARTY1 CONTACT2 
NAME,PARTY2 ROLE,PARTY2 NAME,PARTY2 CONTACT1 ROLE,PARTY2 
CONTACT1 NAME,PARTY2 PRIMARY CONTACT1,PARTY2 CONTACT2 
ROLE,PARTY2 CONTACT2 NAME,PARTY3 ROLE,PARTY3 NAME,PARTY3 
CONTACT1 ROLE,PARTY3 CONTACT1 NAME,PARTY3 PRIMARY 
CONTACT1,PARTY3 CONTACT2 ROLE,PARTY3 CONTACT2 NAME,PARTY4 
ROLE,PARTY4 NAME,PARTY4 CONTACT1 ROLE,PARTY4 CONTACT1 
NAME,PARTY4 PRIMARY CONTACT1,PARTY4 CONTACT2 ROLE,PARTY4 
CONTACT2 NAME,ATTACHDOCUMENT1 NAME,ATTACH DOCUMENT2 
NAME,ATTACH DOCUMENT3 NAME,ATTACH DOCUMENT4 
NAME,ATTACH DOCUMENT5 NAME

CSV File

Each subsequent line after the header represents a contract. It should have contract 
data in the same order as the header. Here are some important formatting rules for 
CSV files:

� Each item in the header must have a corresponding item in data lines with no 
leading or trailing spaces. If the data is null, it should still have an ending 
comma. Note that data is case-sensitive. Example excerpt from CSV with null 
AMOUNT and null END DATE:   

� 1234,Contracts For Sales,Sell,Issue,N,USD,11/02/2001, (…etc.)
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� It is valid to end the line before including data for the last element. Any non 
specified element at the end of a line will be assumed to be null. Example valid 
line from CSV with null parties and attachments:   

� 1234,Contracts For Sales, Sell, Issue, N, USD,112.13,11/02/2001,,,,,some 
short description, some description

� Data with commas should be enclosed in quotes: Example valid excerpt from 
CSV:   

� …… ……,some short description, some description, Customer, AT&T 
Universal Card, No, Buyer, "Bachschmidt, Nicole" 

Attachments File Name

To supplement the CSV File, users can specify a zip file containing attachments. 
Any data in the CSV under the "ATTACH DOCUMENT * NAME" (where * is 1-5) 
must be in the zip file (if no contract in the CSV has attachments, it is not necessary 
to specify a zip file). The name should be the full name of the file, including the 
extension (e.g. MyContract.doc). Note that each contract in the CSV is limited to a 
maximum of five attachments. Extra files in the zip file, that are not referred to by 
any CSV contract, will be ignored.

6.6 Authoring a Contract 
The main purpose of the Create Contract page is to allow users to author a contract 
or create a template that can be used to create contracts, this page is the starting 
point to author a contract. A contract in Contracts Online can get created with 
minimum required information: 

� Entering General Information

� Adding Parties and Selecting Contacts

� Adding Attachments

� Adding Articles

� Standard Articles

� Non Standard Articles

� Previewing Contract

� Granting Access to a Contract
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Prerequisites
The following applies to all pages when creating or updating contracts:

� All fields containing asterisk (*) are required. 

� Status and operations must be setup to allow changes online.

� An active process should not be running.

� Only contracts created via Contract Online can be updated, except attachments 
that can update a Contract created via forms.

� To save changes click Apply.

References
Oracle Contracts Core Implementation Guide, Setting up Status and Operations

6.6.1 Entering General Information
The Create Contract page allows you to author a contract or create a template that 
can be used to create contracts based on a template, this page is the starting point 
for authoring a contract. The type of general information entered for a contract 
includes: Contract Number, Category, Intent, Description, Start Date, End Date, and 
so on. After the information is saved, it is displayed in the Contract Summary page. 
In addition to general information, parties and attachments information are also 
displayed in the Contract Summary page.

Prerequisites:
The user has to have modify access to the contracts category for the given 
responsibility.

Steps
1. Navigate to the Create Contract page by one of the following:

� From the Home Page tab, click the Create Contract link.

� From the Contracts tab, click the Create Contract button.

2. Enter a Contract Number. If you leave it blank the system may automatically 
generate the Contract Number (if autonumber is setup).

3. Choose a Category from the drop-down menu. Categories are seeded and do 
not need to be setup.

4.  Enter a name for Known As that can be used to further identify the contract.
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5. Select an Intent from the drop-down menu.

6. Choose a Perspective from the drop-down menu.

7. Select the Entered option for Status.

8. Select Currency. The field is conditionally required. If there is an amount, then 
the Currency field is mandatory.

9. Enter the Amount for the contract.

10. Select the contract Start Date.

11. Select the contract End Date.

12. Select the Save as Template check box, if you want to save as a template.

13. Enter a Short Description that will enable the contract to be recognized from the 
Summary window.

14. Enter a Description.

15. Enter Comments as appropriate.

16. Click Apply to create a contract. The Apply button saves the contract and opens 
the Contract Summary. If you want to delete all information, click Cancel.

Guidelines
 Updating General Information

The Update General Information page is accessible from the Contracts tab by 
clicking the General Information link:

� The following fields cannot be updated:

� Category

� Intent

� Renewal Number

� Amount

� Amount cannot be changed in case there are lines assigned to a contract, this 
can occur for users that are running both Forms and HTML applications. The 
user could go to Forms and define lines to a contract that was created in 
Contracts Online. In this case the user will not be able to change the amount of 
the contract in Contracts Online.
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� Contract must have Entered as its status. Status can only be changed from 
Entered to Cancelled, Signed, or Active. 

� To change status from Entered to Signed or Active, click Activate. This will run 
the Default QA checklist to validate the contract. 

6.6.2 Adding Parties and Selecting Contacts
Parties and Contacts are used to define the legal parties involved in a contract, 
which one is the primary party, and what their roles are in the contract. After 
defining the parties for a given contract, you can define the contacts assigned to 
each party and specify their roles.

One party can have more than one contact and for each contact role the user can 
define one Primary Contact in a certain period of time. The same contact role can 
have multiple Primary Contacts in different periods of time but not at the same 
time.

Steps
1. Navigate to the Parties page from the Contracts tab by clicking the Parties link 

from the side navigation menu.

2. Click Add Parties. The Add Party page appears.

3. Select a Party Role.

4. Select Party Name to define the party in the contract.

5. Enter a special name in the Known As field to uniquely identify the party.

6. Select the Primary Party check box if the party you are defining is the primary 
party.

7. Click Apply.

8. To Assign Contacts to a Party, select a party.

9. Click Show Contacts. The Contacts Summary page appears.

10. Click Add Contact. The Add Contact page appears.

11. Choose a Contact Role from the drop-down menu.

12. Select a Contact name from the drop-down menu. The Contact Name identifies 
the name of the Contact Role.

13. If this Contact Role is the primary contact, select the Primary Contact check box. 
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14. Select Start and End dates as appropriate for the contact.

15. Click Apply.

16. Repeat procedure for adding additional parties and contacts.

6.6.3 Using Attachments
The Attachments Summary page allows you to list and access all attachments for a 
specific contract. This page also serves as starting point for other pages like Attach 
Files, Attach Web Pages, Update Attachments, and Delete Attachments.

Prerequisites
A user has to have "Read" access to view a contract attachment. Modify access is 
required for Attach Files, Attach Web Pages, Update Attachments, and Delete 
Attachments.

Before using attachments check to ensure that there are no active processes running 
for the contract.

The operation (i.e. update online) has to be allowed in the status and operations 
setup, (irrespective of the current status) before using attachments. 

6.6.3.1 Attaching Files

Steps

1. From the side navigation menu, select the Attachments link. The Attachments 
page opens.

2. If you want to attach a file, click Attach Files. The Attach Files page appears.

3. Enter the Attachment Name.

4. Select the Attachment Type such as Contract Document, email, or note.

5. Click Browse or enter the path where the file will be copied.

6. Enter a Description.

7. Click Apply.

8. Repeat these steps for attaching additional files.
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6.6.3.2 Attaching Web Pages

Steps

1. From the side navigation menu, select the Attachments link. The Attachments 
page opens.

2. If you want to attach a URL, click Attach Web Pages. The Attach Web Pages 
screen appears.

3. Enter the Attachment Name.

4. Select the Attachment Type such as Contract Document, email, or note.

5. Enter the URL for the Web Page Address.

6. Enter a Description.

7. Click Apply.

8. Repeat these steps for attaching additional Web Pages.

6.6.3.3 Updating Attachments

Steps

1. From the side navigation menu, select the Attachments link. The Attachments 
page opens.

2. If you want to Update an Attachment, select the attachment row from the 
Attachments page. The update attachment is used only to change attachment 
name, description and type, this is not intended to allow changes in the 
attached document itself. In case you need to change the attached document, 
you can open the document using an editor, change it and attach the new 
document into the contract.

3. Click the icon in the Update column. The Update Attachment page appears.

4. Enter the necessary changes.

5. Click Apply. 

6. If you want to Delete an Attachment, select the attachment row from the 
Attachments page. You can delete a single or multiple attachments. 

7. Click Delete. A message appears asking for confirmation for deletion of 
selected attachments.

8. Click OK.
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6.6.4 Adding Articles 
The Contract Articles Summary page lists the articles that are defined for a contract. 
This page is the starting point to the add standard article and create non standard 
articles to the individual contract, these pages allow the user to assign standard 
articles from the Library of Articles and/or define non standard articles to the 
individual contract. From the Articles page you can do the following:

� Add standard articles to the contract

� Create non standard articles

� Delete articles

� Update articles

� View articles

When adding an article, you can search from the Library of Articles by name. You 
can select the articles to add to the contract from the Search Results page.

Prerequisites:
A user with Read access can only view articles.

A user will be able to define, update and delete articles according to the following 
rules:

� User access level: Modify Access is required based on the setup of Category 
and Responsibility. In case that the Responsibility has READ access but the 
user is given MODIFY access to the specific contract then the user will be 
allowed to update the contract.

� Contract needs to have status type of Entered.

� There should not be any active processes for the contract that is considered 
for an update.

� Status and Operations needs to be setup to allow changes online.

6.6.4.1 Standard Articles

Steps

1. From the side navigation menu, click the Articles link from the menu on the left 
side. The Articles page appears. For a new contract you will not see any Article 
Name listed.
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2. Click Add Standard Article. The Add Standard Articles page appears.

3. From the Find Articles region, enter a name or "%" to find all articles.

4. Click Go. 

5. From the Search Results page, select the articles you want for the contract.

6. Click Add to Contract. A Confirmation appears and the page shows the articles 
that were added to the contract.

7. If you want to Update an article, select an article.

8. Click Update. The Update Article page appears.

9. Within the Text box, enter revised text.

10. If you want to compare articles, Click Compare. The Comparison Results page 
appears showing changes necessary to convert the original text to the modified 
text. 

11. Click Close.

12. From the Update Article page, click Apply. You will receive a confirmation that 
changes have been saved successfully.

13. If you need to Delete an article, select the article from the Articles page.

14. Click Delete. You receive a warning message confirming the selected article 
deletion.

15. Click Yes to delete. 

Guidelines

When you update a standard article, the identifier for the Standard column changes 
from Yes to No.

6.6.4.2 Non Standard Articles
The non standard articles can be either written as a new article or copied from a 
standard article in the library and modified.

Steps

1. From the Articles page, click Create Non Standard Article. The Create Non 
Standard Article page appears.

2. Select one of the following:
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� Create Non Standard Article from Standard Article (See Guidelines)

� Create Non Standard Article from Scratch

3. Click Next. The Create Non Standard Article page appears.

4. Enter Article Name.

5. Enter Comments.

6. Enter Article Text.

7. Click Apply. The Articles page appears showing a confirmation and the Article 
Name.

8. Click Article Name link to open article for viewing.

9. Click the Return to Articles link. 

10. Repeat procedure for additional articles.

Guidelines

When you select the Create Non Standard Article from Standard Article option, the 
Create Non Standard Article page appears. Enter your changes in the New Text box. 
you can select Apply to associate the article to a contract or Compare to compare 
articles. 

6.6.5 Previewing Contract
The Contract Summary page enables you to preview a contract before printing. This 
enables you to see the entire contract.

Steps
1. Navigate to the Contracts tab. 

2. Enter criteria for contract search.

3. Click Go. 

4. From the Search Results page, click the Contract Number link. The Contract 
Summary page appears.

5. Click Print Preview. The contract appears. 
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6.6.6 Granting Access to a Contract
The Security page enables you to list users and groups that have access to an 
individual contract. If this page does not show any data, it indicates a new contract. 

From the Security page, you can do the following:

� Add users

� Add groups

� Delete user and groups of a contract.

Prerequisites: 
Click the Contracts tab and search the contract that you want to assign privileges. 
Click the Security link to open a read only table that includes users and groups with 
their assigned privileges.

Steps
1. If you want to Add Users, click Add Users. The Add Users page appears.

2. Click Find icon to locate the Name for a User. 

3. Select a Name.

4. Click Go. 

5. Select one of the following Access Levels:

� Modify

� Read

6. Click Apply.

7. If you want to Add Groups, click Add Groups from the Security page. The Add 
Groups page appears.

8. Repeat steps 2-6 for adding groups.

6.7 Updating Library of Articles
The Articles tab provides you the ability to search and view articles in the library of 
articles as well as create new articles and update existing ones. The Articles tab is 
the starting point for the Library of Articles’ information available in Contracts 
Online. 
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The library of articles is a central repository of standard articles. You can create new 
articles and reference them while creating a contract. Usually the library of articles 
is used to store articles that are common to many contracts, and those articles are 
known as standard articles in a contract.

Using Article Release, you can create a new article release for the same article name. 
This is useful when you need to update an article and the latest article release is 
being used for a contract. In this case you can make the updates and create a new 
article release.

The following options are available:

� Create article

� View article

� Update

� Add release

� Delete

Prerequisites
If the article is referenced in a contract, then the Add Release, Update, and Delete 
icons are disabled.

6.7.1 Creating an Article

Steps
1. From the Search Articles Library page, click Create Article button. The Create 

Article page appears.

2. Enter Article Name.

3. Enter Article Release.

4. Enter Release Description.

5. Enter Start Date

6. Enter Text.

7. Click Apply.
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6.7.2 Viewing an Article 

Steps
1. Click the Articles tab within Contracts Online. The Search Articles Library page 

appears.

2. Enter search query.

3. Click Go. The Search Articles Library page appears. 

4. If you want to view an article, click the Article Name link. 

5. Click the Return to Summary link to return to the Search Article Library page.

6.7.3 Updating an Article

Steps
1. From the Search Articles Library page, click the Update icon. The Update 

Article page appears.

2. Enter new or revised text in the Text box.

3. If you want to compare, Click Compare. The Comparison Results window 
appears.

4. Click Close after viewing. 

5. Click Apply. The Search Articles Library page appears showing the updated 
Article Release number.

6.7.4 Adding a New Release 

Steps
1. From the Search Articles Library page, click the Add Release icon. The Create 

Article Release page appears.

2. Enter Article Release number.

3. Save your work.

4. Enter Release Description.

5. Enter Start Date.

6. Enter new text in the Text box.
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7. If you want to compare with the Previous Release, click Compare. The 
Comparison Results window appears.

8. Click Close after viewing.

9. Click Apply. The Search Articles Library page appears showing the new Article 
Release.

6.7.5 Deleting an Article 

Steps
1. From the Search Articles Library page, click the Delete icon when you need to 

delete an article from the library. A Warning page appears confirming the article 
you are about to delete.

2. Choose one of the following:

� Yes: To delete the article

� No: Does not delete the article, you return to the Search Articles Library 
page.
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Using Opportunity Integration

This chapter covers the following topics related to Opportunity Integration:

� Manual Opportunity Creation

� Automatic Opportunity Creation

� Opportunities Handled by Oracle Telesales

7.1 Using Opportunity Integration
Opportunity Integration enables forecast of Contracts revenue directly into Oracle 
Telesales. This creates revenue opportunities in Oracle Telesales from new contracts 
or contracts to be renewed. Opportunity Integration helps in generating an accurate 
sales revenue forecast. Opportunity Integration helps sales representatives track 
contract renewals and prevent loss of revenue.

Business Rules for Opportunity Creation 
An opportunity can be created from the contract only if a category allows it. This is 
controlled by a checkbox in the Define Category form. The other conditions that 
apply on opportunity creation are:

� The contract has an Intent of "Sell". Buy contracts do not result in an 
opportunity.

� The contract has a customer.

� The contract has a salesperson assigned to it from the JTF Sales Group. The 
name of this sales representative should be specified in Contacts region of the 
Parties tab. This is possible only if the Vendor is selected from the Roles drop 
down list.
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� Opportunity is created only when the category of a Contract is enabled for this 
purpose. 

� Opportunity is created only when the lines belonging to an inventory item are 
involved in opportunity creation. When a line and its sub-lines are sourced 
from inventory, only the top line is sent to create an opportunity. The sub lines 
information is available in Oracle Contracts, Oracle Telesales, and Oracle Order 
Capture.

7.1.1 Manual Opportunity Creation 
An entered contract is eligible for Opportunity creation. Opportunities can be 
created through Contracts Authoring > Action > Create Opportunity. This menu 
option is enabled only for contracts in Entered status. Opportunity creation requires 
the following set of parameters:

� Win Probability

� Expected Number of Days to Close

Win Probability can be picked from the list of values (LOV). The initial default 
values for both parameters are set in Telesales. The information entered in the 
Authoring form allows you to override the win probability defined by the profile. 
The expected number of days for closing of an opportunity are calculated as the 
number of days between the current date and the contract start date. If the expected 
closed date is not available, then the contract start date is used. If the expected 
number of days is changed, then the opportunity is created on a corresponding 
date.

Prerequisites
When a contract is in an Entered status, an opportunity can be created and assigned 
to a sales representative, who can view the opportunity via Telesales or Sales 
Online. In the contract on the Parties tab, for the Party role of Vendor, the contact 
must have a role of salesperson and name. This person must also have an associated 
@ FND_USER login name. For example, if the contact person is Abbott, Ms. Rachel, 
even though the name appears in the LOV as salesperson, she must also be 
associated with a user name like TSUSER.

Steps
1. From the Contracts Authoring window navigate to Action > Create 

Opportunity. Create Opportunity window opens.

2. Select the Win Probability 
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3. Select the Expected Number of Days to Close. 

4. Click OK. An Opportunity will be created.

7.1.2 Automatic Opportunity Creation
An opportunity can be created automatically if a contract is set to auto renewal at or 
before expiration. In this scenario, the system will create a opportunity for the 
expiring contract. When the Contract Auto Renewal concurrent process is run, a 
new contract will be automatically created subsequently creating a new 
opportunity.

7.1.2.1 Opportunity Creation During Renewal
An opportunity is created automatically at renewal if the Contract category is 
eligible for opportunity creation. Some values are derived from corresponding 
Oracle Telesales profile values. Contracts will use the default values for Win 
Probability, and Expected Number of Days to Close from the Oracle Telesales profile 
values. 

Steps 
1. Navigate to Contracts Authoring > (T) Summary.

2. Enter the contract Start Date and End Date.

3. Click the Details sub tab. Ensure that the Auto Renewal checkbox is selected 
and the Number of Days Before Expiration field is entered. 

4. Click Rules. 

5. Click Rule Group and select Revenue from the LOV. Subsequently, Rule field 
displays Revenue Estimation. Rule Detail displays Estimation Percent and Date 
Estimate.

6. Enter Estimation Percent. This is a Win Probability.

7. Enter Date Estimate.

8. Click Parties.

9. Select Vendor in the Role LOV. Enter in the name of a valid sales representative 
assigned in the Contracts region.

An Auto Renewal concurrent program is run and creates opportunity when a 
contract is renewed. 
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Opportunity Creation for Contracts about to Expire
When a contract is about to expire and is not renewed, an opportunity can be 
created automatically. This is done using the Events engine. Oracle Contracts Core 
has a "create opportunity" outcome. The Date Based Assembler, a part of the Events 
Engine, will search for the contracts that meet this condition and will create 
opportunities for contracts that are about to expire. 

7.1.3 Opportunities Handled by Oracle Telesales
Once an opportunity is created, it is handled by Oracle Telesales and is manually 
updated by the salesperson and not through any concurrent program. Every 
opportunity has one or more sales representatives assigned to it who can update the 
opportunity information. The other features of Oracle Telesales are:

� A manually created opportunity is created with a status. The status is defaulted 
based on profile options set at the application, responsibility and user levels. 
Only some statuses are not used for forecasting. 

� An Opportunity can be created in any currency. 

� A quote can be created from an opportunity. An opportunity and the contract 
does not remain in sync. An update to one does not automatically update the 
other.

� Products in Inventory will belong to a product category. If an Opportunity is 
not being created for a product, the product category must be specified.

� After an opportunity is created it can be viewed by the sales representative.

Steps
1. Switch responsibility to Telesales Agent. For this, you need to log in as a 

Telesales agent.

2. Navigate to eBusiness Centre.

3. Choose role and group from the LOV in a pop up window.

4. Select Party Type and choose Organization from the LOV

5. Select Organization and choose appropriate value from the LOV.

6. Click Opportunity sub tab. All opportunities are displayed on left. By clicking 
on a specific opportunity, the details are displayed on the right side. An 
opportunity name constitutes of the contract number and the modifier. The 
defaulted fields on that form are Win Probability, Channel, Status, Sales Stage, 
Close Date and Campaign Code (if required).
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